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INTRODUCTION SECTION 

 

Starting MicroStation 

 

To Open MicroStation: 

1) Open the Start Menu 

2) Go to Programs > MicroStation > MDT Preconstruction Startup 
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MDT Preconstruction Startup 

 

 
 

3) Select your Server location 

4) Select your Workgroup 

5) Select the Enhanced Workspace 

6) Select the Production Environment 

7) Click Start MicroStation 

 

Note: The Legacy Workspace should only be used for existing projects using GEOPAK 
Criteria 
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MicroStation Menus and Views 

 

Navigating MicroStation’s Default Layout 

 

Below is the default layout of the MicroStation window. This section will familiarize you 

with the layout and some of the various tools found within MicroStation. 
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The Task Bar  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DGN File Icon appearance 
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Task Bar 

The Task Bar will load on the left side of the screen as shown below.  There are 3 sub-

menus at the next level: Drawing, Drawing Composition, and Terrain Model. 

 

• Drawing includes regular MicroStation commands like Main Classic. 

• Drawing Composition includes several Drawing commands and other commands. 

 

To choose the specific task just click on the arrow and then double click on the menu you 

want to load, and it will load as shown below. 

 

We will default to using the “Drawing” task bar for Introduction classroom usage. 

 

 

 
 

 

• Drawing includes normal MicroStation 

commands, similar to the old Main 

Classic Toolbar. 
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• Drawing 

Composition 

includes several 

Drawing commands 

and other commands. 

 

 

 

 

 

• We won’t cover Terrains in this class. 

To choose the specific task just click on the arrow and then click on the menu you want, 

and it will load below. 

 

We will default to using the “Drawing” Task Bar for Introduction classroom usage. 

 

Right click the Drawing bar for results below: 
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Loading GEOPAK 

Geopak is not available when the Start MicroStation button is chosen. 

 

 
 

 

Note: If the Start OpenRoads button was chosen, GEOPAK is auto-loaded. We will not 

utilize GEOPAK in this Class. 

 

 

 

 

 

 

 

 

 

 

Task Bar Command Views 

You can change the way the commands are viewed. Click on the button and you can 

change it to:  You can also right click and get the same options as show below. 

Icon Layout Mode   List Layout Mode   Panel Layout Mode   Collapse the Group. 
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View Control Menu 

 

 

 

The View Menu location defaults at the top left of the screen and not bottom left.  The 

location can be changed under the pull-down menu Workspace – Preferences – View 

Options – Show View Toolbox. Options are Top, Bottom, Left, & Right or turn it off 

completely. 
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Keyboard Commands 

Note the numbers on the top menu and the letters on the bottom menu.  If you enter the 

number or letter it will open the succeeding menu and then you can enter command 

number or pick it with the mouse.    

 

Note: First highlight, one of three choices in the bar. 

 

Icon\List\Panel:  

 

 

 

 

 

 

Reloading the Task Dialog Menu 

If you close the Task Dialog box you can reload it by doing the 

following. 

1. Choose Tools > Tasks 
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Opening a Design File 
 

While in the “MircoStation Manager” window, navigate to the C:\dgn directory and open 

the intro.dgn file: 

 

1. Navigate the c:\dgn\intro directory and select “intro class” directory. 

2. From “Files:” highlight the appropriate file, INTRO.DGN. (This file will be 

used in other exercises.) 

3. Click Open. 
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Using Key-in Commands 

 

For those users who are more familiar with AutoCAD or those who prefer keying in 

commands, MicroStation has the option of using Key-in commands instead of the 

mouse.1 (Key-ins should not be confused with the MDT custom menu MDT Key-ins).  

 

If you would prefer to use Key-in commands: 

 

1. In the menu bar, go to Help → Key-in Browser 

2. In the Key-in browser, type your command into the Key-in 

area.2 

3. Hit enter or click the Run Key-in Button. 

 

For those who prefer Key-ins, Key-in commands will be included 

in future instructions.  If you want to keep this menu visible but 

smaller, it can be docked like any other menu. 

 

 

 

                                                 
1 The Key-in browser includes an auto finish function. To complete the word, simply hit space bar. 
2 If you have worked with the mouse buttons, prefer them, and/or find Key-in commands cumbersome or 

confusing then just ignore this section and future mentions of Key-ins. 
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Setting up the Mouse 

MicroStation comes set up to accept input from a two-button mouse. Standard MDT 

computers are supplied with three-button mice with scroll wheels. Therefore, you may 

want to adjust the mouse commands for faster input. 

MicroStation calls its graphic input commands buttons. The three MicroStation buttons 

that are needed for standard use of MicroStation are the Data, Tentative, and Reset 

buttons. 

 

Data Button: Execute commands, designate the view in which the commands are entered, 

and accept the commands 

Tentative Button: Executes a tentative or snap to a data point. 

Reset Button: A reset operation completes an action, cancels an action, or rejects an 

identified element. 

 

The MicroStation default mouse settings are: 

Data = Left Mouse Button. 

Tentative = Left and Right Mouse Buttons Together. 

Reset = Right Mouse Button. 

Tentative & 

Zoom in/Zoom 

out 

> WORKSPACE 

> Button Assignments 

 

Next page 
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To adjust the commands of your mouse buttons: 

 

1. Go to Workspace menu. 

2. Click on Button Assignments. 

3. Click on the Remap Buttons option. 

 

This will show you how each button is currently set. The standard MDT setup is shown 

below.  To change the button assignment: 

 

1. Highlight the button to be changed in the dialog box. 

2. Click the button you want to assign to the command in the Button Definition 

Area. 

3. Click on OK when done. 

 

 

 

Key-in: DIALOG BUTTONMAP 
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Palette Manipulation the Task Bar 

 

 

 

 

 

 

Opening individual palettes. 

 

To open a Sub-Palette, hold down the left 

mouse button and select Open as Toolbox 

or select the menu number. Once it is open you may place it anywhere in the work area or 

dock it along the borders. 

 

Opening these palettes will be very useful when you are first using MicroStation, as it 

will allow you to easily see and access all the tools in a Sub-palette. It will also be useful 

later as it will allow you to separate the Sub-Palettes you use most often. 

 

Click (data and hold) on the blue area to move palette around or to dock the palette. 

 
 

X is used to close the palette. 

 

Used to manipulate the palette 

size or rotation of palette. 

 

 

If you have docked the palette and want to 

undock it you need to place your curser on 

the line, hold your data button down, and 

drag it back out into the view window.  



23 

CHAPTER 1 

View Controls 

The View Controls, along with the Scroll Bars, enable you to adjust what you see in each 

view and navigate the design file. The View Control Palette is located at the bottom left 

corner of each View Window.  This same menu with more options can be enlarged and 

placed in the view window or docked.  It is located in the menu under Tools, View 

Control.  Below are the main options. There are many more choices under List when you 

right click on the menu.  
 
 

Update 
View 

 

Zoom 
In 

Zoom 
Out 

Window 
Area 

Fit 
View 

Rotate 
View 

Pan 
View 

View 
Previous 

View 
Next 

Copy 
View 

Demonstrate: To utilize Scroll bar option: Workspace > Preferences > View options > 

Scroll Bars on View 

\Update View: Updates or redraws the contents of a view window.  Each time 

an element is created, deleted, moved, or modified it can affect the appearance 

of the other elements. This tool updates, or redraws, the contents of the active 

window.  

 

To update a view: 

 

1. Click (data) the Update View button in the view you want to update. 

If you have more than one view open, this tool includes a Tool Settings Window that 

allows you to update all view windows simultaneously. 

 

To update all views: 

1)  Click the Update View button. 

2) When the Update View Tool Settings Window opens, click Update All Views. 

 

Update all Views.  

 

 

 

    

 

Note: One must have more than 1 view open to update all  

 

Key-in: UPDATE VIEW EXTENDED <view_window_number> 
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Zoom In: Increases a view window’s magnification by a specified ratio, making 

elements appear larger with increasing detail. 

 

To zoom in using the view control menu:  

 

1. Click the Zoom In button. 

2. Move your pointer into the view.  

A dynamically displayed rectangle indicates what the view’s new boundaries will 

be. 

3. Click where you want the center of the new view to be. 

4. Repeat if needed.  

5. When finished click the reset button or select a different tool. 

 

  
When you have selected Zoom In, this tool includes a Tool Settings Window that allows 

you to set the Zoom Ratio.  The default is set at 2.00. 

 

You can also roll the scrolling wheel forward to Zoom In.  It will zoom in where the 

curser is located. 

 

Key-in: ZOOM IN EXTENDED 

 

 

Zoom Out: Decreases a view window’s magnification by a specific ratio, making 

elements appear smaller with decreasing detail. 

 

To zoom out using the view control menu:  

 

1. Click the Zoom Out button. The view will zoom out once. 

2. Repeat if needed. With repeated zoom outs, you can choose the new center of the 

zoom out by placing the cursor at the desired center and clicking. 

3. When finished click the reset button or select a different tool. 

 

 

When you have selected Zoom Out, this tool 

includes a Tool Settings Window that allows you to 

set the Zoom Ratio. 

 

You can also roll the scrolling wheel backward to Zoom Out. 

 

Key-in: ZOOM OUT EXTENDED [zoom_ratio] 
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Window Area: Indicates a rectangular area in the design that is to be displayed in 

a view.  This is usually done to zoom in.  

 

To Window an area:  

 

1. Click the Window Area button.  A full screen crosshair appears to assist in 

positioning the origin of the area. 

2. Click on the view to indicate one corner/edge of the view’s new boundaries. A 

rectangle is started, indicating the view’s new variable boundaries. 

3. Drag the rectangle to the desired size. 

4. Click again to except the view. 

 

When you have selected Window Area, this tool 

includes a Tool Settings Window that will appear. It 

allows you to choose which view to apply the 

Window Area too. 

 

 

Key-in: WINDOW AREA EXTENDED  

 

 

Fit View: Adjusts the view magnification so that the entire design is visible in the 

view. 

 

To fit a design area into a View:  

 

Click the Fit View button. 

The design in its entirety will fit itself into the active View Window. 

 

 

When you have selected Fit View, this tool includes a 

Tool Settings Window that allows you to set the scope 

of the fit operation. You can choose to display Active, 

Reference, or Raster elements or all three by choosing 

the All setting. 

 

Setting Effect 

All Displays all elements in the active design file and any attached references. 

Active Displays all elements in the active design file. 

Reference Displays all elements in attached references, if any. 

Raster Displays all elements in attached raster references, if any. 

 

 

Key-in: FIT VIEW EXTENDED 
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Rotate View: Rotates the view in the active View Window. 

 

Rotates view but coordinates system does not alter. 

 

To rotate a 2D file view:  

 

1. Click the Rotate View button. A Tool Settings menu will appear. 

2. Select “2 Points” from the drop-down menu next to Method. Click on the point in 

the design that you want to be the axis the view revolves around. A dynamically 

displayed rectangle will appear that delineates the outline of the rotated view. 

3. Use your cursor to control the rotation and click a second time to complete the 

rotation. 

 

To un-rotate a view: 

 

1. Click the Rotate View button.  A Tool Settings menu 

will appear. 

2. Select “Un-rotated” from the drop-down menu next to 

Method. 

3. Click on the view to be un-rotated. The view will 

return to its original, un-rotated orientation.3 

 

In a 3D file, you will have more rotation choices.  This is not 

covered in the Introduction to MicroStation class. 

 

 

 

 

Key-in: ROTATE VIEW EXTENDED 

 

 

 

 

 

 

 

 

 

 

 

                                                 
3 Hint: The farther away your second point is from your axis point, the easier it will be to control the 

rotation. The positive x-axis is straight to your right. No rotation will occur if your second point is on the 

positive x-axis. Be very careful when designing that you always place lines, etc. when the setting is un-

rotated. The angle of lines will always be based on the angle at which they were originally drawn. 

Therefore, any lines drawn while in a rotated view will have different angles than lines drawn while in an 

un-rotated view. 
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Pan View: Allows the viewer to see a different part of the design without changing 

the view magnification.  

 

     To pan a view. 

1. Click the Pan View button. A Tool Settings 

menu will appear. 

2. You may now use your cursor like the hand 

in Adobe. 

3. Click/hold the data button on the mouse and drag the design to the desired new 

center of view. 

 

 Key-in: PAN VIEW 

 

There are two other ways to pan the view of the design file.  Hold the shift key down and 

then click/hold the data button on the mouse.  Drag the curser in the file in the direction 

desired.  This will pan the view of the file.   The next way to pan is to use the scroll bars 

on the right side and bottom of the screen to move the view.  This is similar to Word and 

Excel programs.  You can also use the mouse wheel by holding down the ALT key for 

left and right roaming.  You can also roam up and down if you change ht preferences in 

Workspace – Preference – Mouse Wheel and change the Shift option to Pan Up/Down.  It 

will save these settings for you. 

 

View Previous: Undo a view operation.  

 

 

To undo a view operation, simply click the View Previous button. 

 

Key-in: VIEW PREVIOUS 

 

 

View Next: Redo a view operation.  

 

 

To redo a view operation, simply click the View Next button. 

 

These can be useful if you have zoomed into a small are and then fit view and want to get 

back to that same small area again. 

 

Key-in: VIEW NEXT 
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View Toggles 

View Toggles allows you to navigate easily through multiple (up to eight) View 

Windows at once. You can open or close any of the views by simply using the View 

Toggles. The View Toggles tool window can be found on the bottom left corner of the 

screen. 

 

 

 

View Toggles: Open or close a View Window  

Tip using: Windows > Tile from the MicroStation menu can give you a head start to 

arraging mutlitiplue views in a single file. 

Grids 

Though grids are not used very much at MDT, they provide a good method of 

understanding the concept of the x- and y-axes that the workstation exists on. 

 

To use the grid: 

 

Go to the Settings menu and 

select “View Attributes” or 

press “Ctrl B”. A Dialog 

Window will appear. Once the 

window appears, choose the 

appropriate view from the drop-

down menu; then check the 

“Grid” box and hit “Apply” at 

the bottom left of the Dialog 

window.  

 

 

See Grid snap under Locks, 

zoom to close Grid tightness to 

see Line snap. 
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Creating a design file 

Creating a design file is similar as creating a new Word Document, Spreadsheet, or e-

mail. Simply go up to the File menu and select “New,” or use Ctrl+N. When you select 

“New” a Dialog Window will appear. 

 

 

 

 

 

 

 

 

 

 

When the Dialog Window appears, name your file, and make sure it is in the appropriate 

folder. Once you have done that, you will need to select your Seed File; do that by 

clicking the “Browse” button in the bottom right corner of the Dialog Window. A second 

Dialog Window will appear. 

 

 

 

Or (Create) 

New File 
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When the Seed File Dialog Window appears click on the Seed File “MDT-Seed2D-

Imperial.DGN.”  This will assure that you are working in the correct measuring units 

(MDT standard is feet and decimal feet, rather than meters and millimeters).  The default 

directory should \SEED.  Click OK and this will open a blank design file. 
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Working Units 

To double check that you are using the correct measuring units, or to 

change working units go to the Settings Menu and choose “Design File.” 

A Dialog Window will appear. 

 

When the Dialog Window appears, select “Working Units” at the bottom 

of the “Category” menu. To assure you are working in the MDT 

standard, select the second “Feet” option under “Master Unit” (the first is 

Survey Feet) and “decimal, foot” under “Sub Unit”. The “Label” options 

should change themselves to “ft” and “tn” = tenth respectively.4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LEGACY:  1000 

EHANCED:  10000 

 

 

 

 

 

 

                                                 
4 It is recommended that the MDT CADD Standard Seed files be used for MDT projects.  Modifications to 

the working units can create significant problems with design work. 
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Help 

MicroStation has one of the most complete, detailed and comprehensive Help 

files of any computer program on the market – designing or otherwise. While this is 

impressive and very useful, the massive amount of information contained in the Help file 

can be rather daunting. However, you should keep in mind that the help file is designed to 

be user friendly and can be easily navigated. 

 

Firstly, if you go to the Help menu and select “Contents,” the Help Dialog 

Window will open. The Help Dialog Window is fairly versatile – letting you select what 

you want from a list or use the search function if you don’t know where to find your 

answers. In addition, the entirety of MicroStation is indexed – so you can search that way 

as well. If you find yourself looking up particular subjects often, you can even add them 

to a “Favorites” list, so you don’t have to do a search every time. 

 

“F1” or HELP menu pulldown 
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To use Tool Tips 

Go to the Help menu and click on “Tool Tips.” A check mark will 

appear next to the option. Once “Tool Tips” is turned on, pale yellow 

informational bubbles will appear when you hover your mouse over a 

tool, view control, view group, or even design element. 

 

 

 

 

 

 

 

 

To use Tracking: 

Go to the Help menu and select “Tracking.” Just as with “Tool Tips,” a check mark will 

appear next to the option. When “Tracking” is on, every time you select a tool from the 

View Controls or Main Palette “Tracking” will open the Help Dialog Window to the page 

on whatever tool you are using. 

 

In addition to the Help Dialog Window, the Help menu has several other quite useful 

features. One of those is the “Tool Tips”  
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AccuDraw 

 

One thing you may notice when you begin placing elements is a crosshair 

around your cursor. AccuDraw can be a very useful tool. You can turn it 

off by selecting the AccuDraw toggle in the Primary Tool Bar.  You can 

permanently turn AccuDraw off by opening the AccuDraw Settings dialog 

box under pull down menu Settings - AccuDraw. Check off the option for 

Auto Load. 

 

List of basic AccuDraw Shortcut Key-ins 

The following table lists keyboard shortcut and its effect. Additional information about 

the effect of individual keyboard shortcuts is presented in the general discussions of 

AccuDraw procedures. 

DO NOT USE ACCUDRAW WITH CIVIL TOOL (YOU MUST TURN IT OFF) 

Key Effect 

<Enter> 

Smart Lock 

• In Rectangular coordinates, locks X to 0 if the pointer is on the drawing 

plane y-axis or Y to 0 if the pointer is on the x-axis. 

• In Polar coordinates, locks Angle to 0°, 90°, -90°, or 180° if the pointer is 

on a drawing plane axis or otherwise locks Distance to its last entered 

value. 

<Space 

bar> 
Switches between Rectangular and Polar coordinates. 

<V> 
Rotates the drawing plane to align with the view axes. Pressing this key a second 

time restores context-sensitive rotation. 

<T> 
Rotates the drawing plane to align with the axes in a standard Top view. Pressing 

this key, a second time restores context-sensitive rotation. 

<A> Switches the lock status for the Angle value. 

<Q> Deactivates AccuDraw. 

 

Keyboard shortcuts are not case sensitive. 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/MicroStation%20V8i%20(SELECTseries)/Documentation/MicroStation.chm::/ustnhelp1086.html#N003300000000054B
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/MicroStation%20V8i%20(SELECTseries)/Documentation/MicroStation.chm::/ustnhelp1086.html#N003300000000054B
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The Task Palette 

 

 

 

NEW Task style: 

 

NEXT PAGE 
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Task method: (Recommended method) 

 



37 

 

The Element Selection Sub-palette 

 

Element Selection is a versatile tool that can mimic many of the actions of other 

tools, though it may be less exact. 

 

 

 

 

 

Key-in: CHOOSE ELEMENT 

 

The Element Selector Tool can be use like a fence. It will fence and highlight all of the 

elements entirely inside the fenced area. It also can be used to highlight individual 

elements. If the element or elements are highlighted, you can manipulate them like delete 

or drag and move them. 

 

Tip: Hold down the “Ctrl” key to add or remove entities from your selection set. 

 

Individual   Block   Shape   Circle   Line   Handles on\off 

        

  

 

 

 

 

 

 

 

 

New   Adds to   Subtracts   Invert selection*   Selects all 
(*Invert works with Block method to invert selection) 

 

Method: Individual,     

Block Inside, Block Overlap, Shape Inside, Shape Overlap, & 

Line. 

 

Mode: Add, Subtract, Invert, New, & Clear/Select All. 

 

Attribute Tabs: Lv (Level), Co (Color), Lc (Line Style), Wt 

(Weight), Ty (Type), & Cl (Class). 

 
In the extended settings for the Element Selection window, tabs let you select elements by one or more 

attributes — Level, Color, Line Style, Line Weight, Element Type, Element Class, Element Template, Text 

Style, Dimension Style, Multi-line Style, Transparency, and Display Priority. Alternatively, when you 

select elements graphically, the active set of attributes displays as a highlighted group in each tab's list box. 

Power Selector 
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Linear Elements Sub-Palette 

One of the most basic elements you place will be lines. They are also the one of the most 

used elements. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Place SmartLine 

 

 General tool for placing open or closed linear elements. 

 

 

To place a SmartLine: 

 

1. Select Place SmartLine Tool. 

2. Select the Segment Type. 

a. Line - to create line 

segments. 

b. Arc - to create arc segments. 

3. Select the Vertex Type. 

a. Sharp - no rounding or 

chamfering. 
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b. Rounded - Rounds vertex by radius specified. 

c. Chamfered - Chamfers vertex by offset specified. 

4. Toggle Join Elements on/off. 

a. On - The segments will create a closed chain upon snapping to the first 

vertex point. 

i. A close cursor will appear when near first point if you require a 

closed shape, accept to complete if applicable. 

ii. On - Select Area Type, Fill Type and color. 

b. Off - The segments will remain separate elements that may have different 

symbology. 

 

Key-in: PLACE SMARTLINE  

Place Line:  

 

General tool for placing line segments. 

 

 

To place a Line:  

 

 

Placing a line is almost exactly the same as placing a 

SmartLine. The only real difference is that with 

SmartLine, you can make all of the line segments into a 

single element and you can create different effects with 

the Vertex Type. However, when placing a line you can 

also manually input a particular length and/or angle – 

this is helpful if you need to place several lines that are the same length and at the same 

angle, but don’t necessarily come into contact with each other. 

 

 

Key-in: PLACE LINE [CONSTRAINED | ANGLE] 

 

 

 

The following will not be covered in the Introduction to MicroStation class: 

Place Multi-Line 

Place Stream Line String 

Place Point or Stream Curve 

Construct Angle Bisector 

Construct Minimum Distance Line 

Construct Line at Active Angle 
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Ellipse Sub-Palette 

 
 

Another basic element you will be using is the ellipse. 

 

Place Circle  

 

Place a Circle 

 

 

 

To Place a Circle: 

 

1. Click the Place Circle button. A Tool Settings window will appear. From here, 

you have several options: you may draw your circle by establishing the center 

point and moving outward, by establishing two points along the outside edge of 

the circle and using a third point to complete your circle, or by establishing one 

point and using the second point to determine the diameter of the circle. 

2. Once you have decided on the Method, you will need to decide on the Area type: 

either Solid or Hole. After the Area type, you will need to choose between the 

three different Fill types: None, Opaque and Outlined. 5 Depending on your Fill 

choice, you may also be able to choose a color. 

3. After the Area type, you will need to choose between the three different Fill 

types: None, Opaque and Outlined. Depending on your Fill choice, you may also 

be able to choose a color. 

4. If you want to make several circles of the same size, you may choose to set the 

Radius or Diameter to a particular increment. 
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5. Once you have made all your choices click the Data Button where you want your 

circle to be in the Workstation, make your circle the desired size, and click the 

Data Button again to accept the circle. 

 

Key-in: PLACE CIRCLE ICON or PLACE 

CIRCLE < CENTER | EDGE | DIAMETER > 

[CONSTRAINED] 
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Place Ellipse 
 Place an ellipse.  

 

 

To place an ellipse: 

 

1. Select the Place Ellipse button. A Tool Settings Window will appear. The 

options for placing an ellipse are nearly identical as those for placing a circle. 

The only difference is that when making an ellipse there is no “Diameter” 

setting. 

2. If you want to set the size and angle of rotation of the ellipse, you can do so 

by typing in the length of the Primary and/or Secondary axis radius and the 

angle of Rotation. 

3. Once you have made your choices you can place your ellipse just as you 

would a circle. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Key-in: PLACE ELLIPSE ICON or PLACE ELLIPSE < CENTER | EDGE > 

CONSTRAINED 
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Arcs Sub-Palette 

The Arc Sub-Palette will not be so widely used as the Linear Elements Sub-Palette, 

however it does contain some very useful tools. 

 

 
 

 

Place Arc 
Place a circular arc. This will probably be the most useful 

tool in the Arc Sub-Palette. 

 

 

To place an arc: 

 

1. Choose your method; your choices are “Start, 

Center”, “Center, Start”, Start, Mid, End” and 

“Start, End, Mid”. 

2. If you want to make several arcs with the same measurements you can use the 

“Radius,” “Length,” “Start Angle,” and “Sweep Angle” options to set your 

measurements.  Keep in mind, setting the “Radius” and “Length” means that the 

“Sweep Angle” will set itself accordingly. 

 

Key-in: PLACE ARC ICON or PLACE ARC < CENTER | EDGE > CONSTRAINED 

 

Placing a Partial Ellipse 

 

Neither of the tools for placing partial ellipses is used very often at MDT. Both work on 

the same principle of using three points to establish the path of the elliptical arc. 
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Place Half Ellipse 
Place an elliptical arc with a sweep of 180 degrees. 

 

Key-in: PLACE ELLIPSE HALF 

Place Quarter Ellipse 
Place an elliptical arc with a sweep of 90 degrees.  

 

 

 

 

Key-in: PLACE ELLIPSE 

QUARTER 

 

 

 

 

 

 

 

 

 

 
Arc-specific Modification Tools 

 

Modify Arc Radius 

 
Modify the radius, sweep angle, and center of circular arc. 

 

 

To modify an arc’s radius, sweep angle, and center:  

 

1. Select the Modify Arc Radius button. 

2. Select the arc you wish to modify. Adjust the radius, sweep angle, and center as 

you need. 

 

Key-in: MODIFY ARC RADIUS 
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Modify Arc Angle 

 
Extend or shorten the length (sweep angle) of an arc.  

 

 

To modify the length (sweep angle) of an arc:  

 

1. Select the Modify Arc Angle button. 

2. Select the arc you wish to modify. Adjust the sweep angle as needed. 

 

Key-in: MODIFY ARC ANGLE 

 

 

Modify Arc Axis 

 
Change the major or minor axis radius of an arc. 

 

 

To modify the major or minor axis radius of an arc:  

 

1. Select the Modify Arc Axis button. 

2. Select the arc you wish to modify. Adjust the axis radius as needed. 

 

Key-in: MODIFY ARC AXIS 



46 

Polygons Sub-Palette 

 

 

 

 

 

 

 

 

 

Another of the most basic palettes is the Polygons Sub-Palette.  

 

Place Block 

 
Place a regular four-sided polygon.  

 

 

To place a block:  

 

1. Select the Place Block button. A Tool Settings Window will appear. 

2. Using the drop-down menu next to “Method,” choose either “Orthogonal” or 

“Rotated.” An orthogonal block will be oriented on the locked x- and y-axes and 

is established with two data points, while a rotated block can be oriented in any 

direction and is established with three data points. Next, choose the Area and Fill 

types (same choices as previous shapes). 

3. Place your cursor over a point in the workstation and enter your first data point. If 

method is set to Rotated, enter a data point to define the orientation. Then (for 

either method), define the dimensions of the block by placing your last data point; 

this point should be diagonally opposite the first data point. 

 

 

Key-in: PLACE BLOCK ICON or PLACE     

BLOCK [ORTHOGONAL | ROTATED] 

 

If done with accudraw option on: 
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Place Shape 

 
 

 

 

To place a shape: 

 

1. Select the Place Shape element. A Tool Settings Window will appear; set the Area 

and Fill types. 

2. If you want the shape to be particular dimensions, you can set the Length and 

Angle options to the desired measurements. If not, simply enter data points in the 

workstation to make your shape. 

3. To close your shape, you can do one of three things. Either use the Close Element 

button in the Tool Settings Window, or simply close the element by dragging your 

cursor back to the beginning data point. For those who like Key-ins, you can also 

use the command CLOSE ELEMENT 

 

 

 

 

 

 

 

 

 

 

 

 

Key-in: PLACE SHAPE CONSTRAINED 

 

 

Place Orthogonal Shape 

 
Place a shape in which each segment is perpendicular or parallel to the others. 

 

To place an orthogonal shape: 

 

1. Select the Place Orthogonal Shape element. A Tool Settings Window will appear. 

2. Set the Area and Fill Types and place your shape. 

 

 

 

 

 

Key-in: PLACE SHAPE 

ORTHOGONAL 
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Place Regular Polygon 

 
Place a regular polygon. 

 

 

 

To place a regular polygon: 

 

1. Select the Place Regular Polygon element. A Tool Settings Window will appear. 

Select the Area and Fill Types. 

2. Select your Method; you may choose from Inscribed, Circumscribed, or By Edge. 

Both Inscribed and Circumscribed are placed by selecting the center point and 

moving outward; however, “Inscribed” is controlled by a vertex point and 

Circumscribed is controlled by an edge point. 

3. Next, enter the number of sides you want your polygon to have in the Edges field. 

At this point, you may enter your first data point and drag your cursor out until 

your polygon is the desired size and has the desired orientation. However, if you 

want your polygon to be a specific size, you may enter the radius into the Radius 

field and simply rotate your polygon until it has the desired orientation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Key-in: PLACE POLYGON ICON or PLACE POLYGON [INSCRIBED | 

CIRCUMSCRIBED | EDGE] 
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Manipulation Sub-Palette 

 
 

The Manipulation Sub-Palette is probably one of the most important sub-palettes in 

MicroStation. It contains all the tools you need to manipulate any element. 

 

 

Copy Element 

 
Copies an element or group of elements to a new location. 

 

 

 

To copy an element:  

 

1. Select the Copy Element button. A Tool Settings Window will appear.  Choose 

the number of copies you wish to make and select the element or group of 

elements you wish to copy. 

2. Move the copied image to its new location and enter a data point.  

 

The Use Fence options are only if you have 

used a fence to decide what to copy.  

Fences will be covered later in the course. 

 

Key-in: COPY ICON or [FENCE] COPY 

[ELEMENT 
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Move Element 
 

Move an element to a new location.  

 

 

Moving an element is exactly the same as copying an element, with the one exception 

that the Copies field is not turned on. 

 

 

Key-in: MOVE ELEMENT or [FENCE] MOVE 

[ELEMENT] 

 

 

Move/Copy Parallel 
Move or copy an element parallel to original orientation. 

 

 

To move/copy an element parallel:  

 

1. Select the Move/Copy Parallel element. A Tool Setting Window will appear. 

2. Choose the desired Mode from Miter, Round, or Original. Probably the most used 

Mode at MDT is the Original mode; the Original mode maintains the element 

type of the original element. However, in the case of Arcs and Ellipses, that the 

resulting element is not a true parallel. The Miter mode creates a true parallel in 

the case of Arcs and Ellipses, but the true parallels are b-spline curves rather than 

Arcs and Ellipses. So, if you want to maintain the original shape, use the Original 

mode, but if you want to create a true parallel, use the Miter mode. The Round 

mode simply rounds corners in polygons and lines. 

3. Once you have chosen your mode, you may click on the element you wish to 

move/copy. Drag your cursor to the new location and enter a data point. If you 

want the element or element copy to move a certain distance, you can turn on the 

Distance field and enter the desired distance. 

4. Turning the “Make Copy” field on or off works like a toggle, switching between 

Copy Parallel and Move Parallel. 

5. Turning the “Use Active Attribute” field on will change the attributes of the 

copied or moved element to the current active attributes; leaving it off will mean 

the copied or moved element will maintain the original attributes. 

 

 

 

 

 

Key-in: MOVE PARALLEL ICON or 

[COPY | MOVE] PARALLEL 

[DISTANCE | KEYIN]
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Scale Element 
 

Resize an element.  

 

 

To resize an element: 

 

1. Select the Scale Element button; a Tool Settings Window will appear. 

2. Choose the Method you wish to use from Active Scale or 3 Points. If you choose 

Active Scale, you may set the increment by which the element(s) will be scaled. If 

you choose 3 points, you can manually select three points around which the 

element(s) can be scaled. 

3. You may also choose whether you wish to make copies of the original element or 

simply to scale the original. 

 

3D File Options     2D File Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Key-in: SCALE ICON or [FENCE] SCALE [POINTS] [COPY | ORIGINAL] 
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Rotate Element 
 

Rotate an element.  

 

 

To rotate an element:  

 

1. Select the Rotate Element button; a Tool Setting Window will appear. 

2. Choose your Method. If you choose Active Angle, you can enter in the 

desired rotation. With 2 Points, you select two points and rotate the element 

around them. 3 Points is the same, but with three points instead of two. 

3. Again, you may choose to make a copy or not. 

 

 

 

 

 

 

 

Key-in: ROTATE ICON or [FENCE] [ROTATE | 

SPIN] [COPY | ORIGINAL | POINTS] [COPY | 

ORIGINAL] 

 

Mirror Element 
 

Mirror an element.  

 

 

To mirror an element: 

 

1. Select the Mirror Element button; a Tool Settings Window will appear. Again, 

you may choose to make a copy or not. 

2. Choose the direction in which you want the element to be mirrored by using the 

drop-down menu next to “Mirror About.” You may choose Vertical, Horizontal, 

or Line: Vertical will mirror across a vertical axis, Horizontal will mirror across a 

horizontal axis, and Line will mirror across a line you establish by selecting two 

points. 

 

 

Key-in: MIRROR ICON or [FENCE] 

MIRROR [COPY | ORIGINAL] 

[HORIZONTAL | LINE | VERTICAL] 
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Align Elements by Edge 
 

 

 

To align elements by edge: 

 

1. Select the Align Elements button; a Tool Settings Window will appear. 

2. Use the drop-down menu next to “Align” to select the edge by which the elements 

should be aligned with. 

3. Select the element with the desired alignment, and then click twice on each 

element you want to have the same alignment. Click the Reset button when all of 

the desired elements are aligned. 

 

 

 

Key-in: ALIGNEDGE 

 

 

 

 

 

 

 

 

Either 2D or 3D move one or more elements in a defined direction until they make 

contact with another element. If no element is in the path, then the element is not moved.  

Box on right stops at first contact as below: 
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Construct Array 
 

Copy an element many times to create an array.  

 

 

To construct a rectangular array: 

 

1. Select the Construct Array element; a Tool Settings Window will appear. 

Depending upon the Array Type you choose, the Tool Settings Window will look 

differently. 

2. Choose “Rectangular” for the Array Type. Next choose the Active Angle; you 

may choose one of the four preset angles (90˚, 180˚, 270˚, or 360˚) or type in your 

own angle. 

3. Now select the numbers of Rows and Columns in the array; you may keep the 

default (two) or type in your own. Lastly, choose the spacing between each Row 

and Column. 

4. Select the element you wish to copy by using the Data Button, and make the 

copies by hitting the Data Button again. 

 

 

 

 

 

 

 

 

 

 

 

To construct a polar (circular) array: 

 

1. Select the Construct Array element; a Tool Settings Window will appear. 

Depending upon the Array Type you choose, the Tool Settings Window will 

look differently. 

2. Choose “Polar” for the Array Type. Next, you will need to select the number 

of Items (copies – include original element in this number) and the Delta 

Angle (angle between each copy). Decide if you want the copies to be rotated 

or not. 

3. Select the element you wish to copy by using the Data Button and make the 

copies by hitting the Data Button a second time. 

 

Key-in: ARRAY ICON or [FENCE] ARRAY 

[RECTANGULAR | POLAR] 
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Drop Element 
 

Drop status on an element. To drop status on an element means it will break up the 

complex elements into their individual components 

 

 

 

Drop Complex Status 

 

1. Select the Drop Complex Status tool. 

2. Identify the complex element. 

3. Accept the drop. 

4. Other element status can be dropped also. 

 

     Key-in: Drop Complex 

 

 

 

 

 

Delete Element Command 

 

 

Delete Element: Deletes elements.  

 

 

There are several ways to go about deleting design elements. You may select the Delete 

Element button and then Data click on the element you wish to delete.  This will 

highlight the element and then data click again to accept and delete it. You may also use 

the element selection tool to select the element(s) you wish to delete.  Then hit the Delete 

button. You may also select the element you wish to delete and pick the <Delete> or 

<backspace> key on the keyboard. 

 

Key-in: DELETE ELEMENT 
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Editing 

 

While drafting you are likely to make mistakes. Luckily, MicroStation comes equipped 

with an edit function. In addition to the more commonly found Cut (Ctrl+X), Copy 

(Ctrl+C), Paste (Ctrl+V), Undo (Ctrl+Z) and Redo (Ctrl+R) functions; MicroStation also 

comes with the “Undo To Mark” and “Undo All” functions. 

 

 

 

 

 

 

 

 

 

 

 

You can access most of these functions by going to the Edit menu and selecting 

whichever function you need. These tools are also located in the Standard Tool Bar, 

which should docked with the Tool Bars at the top of the screen (though it can be moved 

anywhere). If this Tool Bar is not on when you open MicroStation, you can turn it on by 

accessing the Tools menu and selecting “Standard.” 

 

Commands:    

Undo 

 

Will Undo Last Placement or Element Manipulation. 

Undo Command to Last Compress.                               

 

 Key-in: Undo 

Undo All 

Will undo everything that has been done since the last time the file was compressed. 

 

Key-in: UNDO ALL 

 

Undo to Mark 

Will undo everything that has been done since the last time you set a Mark. You set a 

mark by going to the Edit menu and selecting “Set Mark.”  

 

Key-in: UNDO MARK 
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Saving a File 

MicroStation is continually saving your design file. 

Save As will save your file with a new name and in a location, that you designate and 

then closes the open DGN file and opens the newly saved DGN file. 

Save will save your file at that particular moment.  This option is used if you have the 

automatic save settings turned off.  This is not covered in this course.  You should keep 

this option on all the time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Backing Up a File 

Backing up a file is executed by typing Backup in the Key In Browser command line.  It 

will automatically place a file in the C:\Dgn directory with a .BAK extension rather than 

.DGN extension.  It will not automatically open up the DGN file. 

 

Key-in: BACKUP 
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Compressing a File 

Every time you place, move, modify, or delete an element it takes up space on the 

memory buffer. Using the undo and redo functions also takes up space on the memory 

buffer. In fact, you can use up enough 

space that it becomes difficult to use any 

of those functions; in order to avoid 

slowing (or stopping altogether) your use 

of these basic utilities you need to 

compress your files. Compressing a file 

is like wiping the computer’s memory of 

when you placed, moved, modified, or 

deleted elements. It still recognizes that 

the elements are there in the file, it just 

does not remember the steps taken to 

place the elements wherever they are. Essentially, it sets a new beginning point for the 

design. You can still move, change, or delete old elements and add new ones, you just 

can’t undo (or redo) anything from before you compressed the file. 

 

You compress a file by going to the File menu, placing your cursor over “Compress” 

until the drop-down menu opens, then select “Design.” If you haven’t compressed your 

file in while it will take longer than if you compress it fairly often. In fact, you can set 

your design files to compress whenever you exit MicroStation, so you do not have to 

repeat the compression process. Simply go to the Workspace menu and select 

Preferences. A dialog window will appear. Once the Dialog Window opens, select the 

“Operation” Category. Next turn on the “Compress File On Exit” Operational Preference. 

Click OK and the file will compress every time you exit the file.  This is recommended if 

you check out and check in files from DMS. 

 

Key-in: COMPRESS 
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Save Setting 

Another Operational Preference you may want to take advantage of is the “Save Settings 

on Exit” preference. Turning this preference on means that all of the settings you are 

using at the time you exit the file will be the same when you next open the file. For 

example, any Sub-Palettes you have ripped will stay where you put them and any menus 

you have moved or turned on or off will remain that way. To utilize this preference, go to 

the Workspace menu and choose preferences again. This setting is also under the 

“Operation” Category. Turn it on and click OK.  This can be done at any time by opening 

the File → Save Settings or type in “Ctrl F”. 

  

WORKSPACE > PREFERECNES > OPERATION 
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CHAPTER 2 

Fence Sub-Palette 

 

Fence Contents Locks 

INSIDE (default) - Affects elements completely 

enclosed by fence. 

OVERLAP - Affects elements inside or crossing the 

fence. 

CLIP - Affects elements or parts of elements enclosed 

by fence. 

VOID - Affects elements completely outside fence. 

VOID – OVERLAP - Affects elements outside and 

crossing the fence. 

VOID – CLIP - Affects elements or parts of elements 

outside fence.   

Fence Window 

It will be shaded Green or Red.  Green is for Inside commands and red is for Void 

commands and have a solid line around the fence.  Overlap and Clip have different 

dashed lines for Inside and Void. 

Place Fence Block 

Places a rectangular fence around a particular user defined 

area. 

 

1. Enter data point to define Select Place Fence tool.  If a 

fence exists, it is removed. 

2. Enter data point to define one corner. 

3. diagonal point 

 

 

 

      Key-in: Place Fence Block 
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Fence Shape 

Places a multi-sided fence around a particular user defined area 

 

1. Select Place Fence tool. If  a fence exists, it is 

removed. 

2. In the Tool Settings window, set Fence Type to 

Shape. 

3. Enter a data point to define the beginning (and end) 

point. 

4. Continue to enter data points to define the vertices. 

5. To close the shape, enter a data point at the location 

of the first data point. 

6. Or click the Close Fence button. 

 

 

Key-in: Place Fence Shape 

 

Fence Circle  

Places a circular fence around a particular user defined area. 

 

1. Select the Place Fence tool. If a fence already 

exists, it is removed. 

2. In the Tool Settings window, set Fence Type to 

Circle. 

3. Enter a data point to define the center. 

4. Enter a data point to define the radius. 

 

 

 

    

 

 

 

 Key-in: Place Fence Circle 
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Modify Fence Vertex  

User modifies an existing corner location of a fence. 

 

1. Select the Modify Fence tool. 

2. Set the tool setting Modify Mode to Vertex. 

3. Identify the vertex to move. 

4. Enter a data point to define the new vertex position. 

5. Reset to accept the modification.  

 

     

 

Key-in: Modify Fence 

 

 

Modify Fence Position 

 

Move Fence  

User moves a fence to a different location. 

 

1. Select the Modify Fence tool. 

2. Set the tool setting Modify Mode to Position. 

3. Enter a data point to define the origin for the move. 

4. Enter a data point to define the new fence position. 

This data point precisely positions the origin. 

5. Reset to accept the move.  

 

Key-in: Move Fence 
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Delete Fence Contents  

User deletes elements entirely inside of fence 

 

1. Select Delete Fence tool. 

2. Accept the deletion 

 

 

 

 

 

 

Key-in: Fence Delete 

 

Copy Fence Contents  

User can manipulate elements inside of fence. 

 

1. Fence elements. 

2. Determine fence mode. 

3. Select the Copy tool. 

4. Identify the origin of the elements. 

5. Enter data point(s) to position each copy. 

6. Reset to finish.  

 

       

 

Key-in: Fence Copy Element 

 

 

Move Fence Contents 

User can move fence contents. 

 

 

1. Fence elements. 

2. Determine fence mode. 

3. Select the Move tool. 

4. Identify the origin of the elements. 

5. Enter data point(s) to re-position the 

fenced elements. 

6. Reset to finish.  

 

 Key-in: Fence Move Element 
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Drop Fence Contents 

User can drop status on elements in fence.  To drop status on an element means it will 

break up the complex elements into their individual components. 

 

1. Fence elements. 

2. Determine fence mode. 

3. Select the Drop Status tool. 

4. Enter data point in fence. 

 

 

 

 

 

 

 

 

 

V8i provides the capability to save fences with a name and or a description to be recalled 

for usage at later time:  

 

 
 

Activate 

Delete 

Save 
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Attribute Palette 

 
 

Change Element Sub-palette 

 

A user can change the symbology of an element. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select Change Element Attribute tool. 

1. Toggle on attributes to be changed. 

2. Identify the element. 

3. Accept to change. 

…takes on current attribute 

settings. 
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Click on eye dropper to activate Match Element Attributes option. 

 
Change Element Attributes: Change an element(s) attributes to the active setting(s) 

Change to Active Area: Change the area of a closed element(s) to the active area. 

Change to Active Fill Type: Change a closed element to the active fill type. 

Modify Line Style Attributes: Dynamically modify the line style attributes of an element. 

Change Multi-Line: Change a multi-line’s attributes to the active definition. 

Match Element Attributes: Change the active attributes to match those of an existing element. 

SmartMatch: Match all element settings. 

 

From Settings menu, choose 
Design File 

 

Active Angle  

 

Angle - set active angle  

 

Angle Lock - rounds angle to 

tolerance 

 

Tolerance - factor that angle lock 

rounds to 

 

Key-in: AA= [angle] 

 

(Use text placement to demonstrate AA= changes) 
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MDT MDL TOOLS 

 

  

Set Active Angle Graphically by 2 points  

(From Road Tools > MDT Tools > MDT KEYINS)  

1)   Enter data point for origin of an imaginary line 

 

2)   Enter data point for endpoint of line 

 

       Key-in Active Angle Pt 2 

 

Note: The Active Angle is set to the angle measured 

counter-clockwise between this line and the positive view 

x-axis. 

 

 

 

 

 

 

 

 

Set Active Angle Graphically by 3 points  

(From Road Tools > MDT Tools > MDT KEYINS)  

 

1)   Enter data point for endpoint of first side of angle 

 

2)   Enter data point for vertex of angle 

 

3)   Enter data point for endpoint second side of angle 

 

       Key-in Active Angle Pt 3 

 

Note: The Active Angle is measured counter-clockwise                                                          

from the first data point to the third data point. 
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Setting Active Scale Dialog 

(From the Settings menu, choose Design File...) 

 

Active Scale  

 

X Scale - sets active x-scale 

 

Y Scale - sets active y-scale 

 

Lock Control - lock scale factor the same 

 

1.0 - sets scale factor to 1.0 

 

Half - multiply scale factor by 0.5 

 

Double - multiply scale factor by 2 

 

Scale Lock - rounds scale to tolerance 

 

Tolerance - factor that scale lock rounds to 

 

Key-in: AS = [scale] 

 

Note: A 2D file will not have an option to scale in the Z. 
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Set Active Scale Graphically   

(From Tools menu choose MDT Custom - 

Keyins) 

 

1) Enter data point of known location or 

keypoint 

 

2) Enter data point of second known location 

or keypoint 

 

3) Enter data point to define active scale 

factors 

 

      Key-in: Active Scale Distance 
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Saved Views 

You have already learned how to navigate within and between views; however, one of 

the most helpful view features in MicroStation is one that you have yet to learn. In 

MicroStation you can save particular views in a design file for later use. This feature is 

located under: Utilities > Saved Views. 

Saving a View 

Navigate the view in the workstation until you have the desired view, then select “Saved 

Views” in the Utilities menu. Click the create view button; a second dialog box will 

appear.  

 

Fill out the Name, Description etc…dialogs as required then select the view you wish the 

save to be associated with. 

 

Opening a Saved View: 

 

To open a previously saved view, select “Saved Views” from the Utilities Menu. The 

Saved Views dialog window will open. Select the view you wish to apply and then select 

the view you wish to apply it to. 

Deleting a Saved View 

To delete a saved view, select the view from the Saved Views dialog window then click 

the saved view delete button. 
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Saved view selections are also available at the 

extreme left corner button of the MicroStation view.  
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CHAPTER 3 

Snaps (Tentative Button) 

 

Snaps are probably one of the most useful tools in MicroStation, especially when it 

comes to placing, moving, or modifying elements. Snaps allow you to place, move, and 

modify with much more precision and accuracy; making it possible to join elements at 

precise points or using a point to define the orientation of an element. To turn on the 

Snap Button Bar, go to the Settings Menu. Highlight the Snaps option; when the 

drop-down menu opens, choose “Button Bar.” The button bar will appear on the 

screen.  You can also open the Snap Button Bar at the bottom of the screen in the status 

bar.  When a snap button is grayed out it is the default choice.  If you want to choose a 

different snap for your default, then double click on it and it will become grayed. 

 

 
 

 

If you right click on any button and choose List, you can turn off any snap button and it 

will not be included in the Snap Mode palette.  To turn it on just check it on. 

 

 

 

Nearest Snap Point:   

 

 

Using the Nearest Snap point allows you to snap to the nearest point on any element.  

 

Key-In: SNAP <NEAREST> 

 

Keypoint Snap:  

 

 

 

This is the most generally useful of the snaps. It allows you to snap to the nearest 

Element Keypoint.  Snaps to the nearest vertex. 

 

 

 

 

Key-In: SNAP <KEYPOINT> 
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Midpoint Snap:  

 

 

The Midpoint Snap allows you to snap to the midpoint of the segment closest to the 

pointer. 

 

Key-In: SNAP <MIDPOINT> 

Center Snap:  

 

 

The Center Snap allows you to snap to the center of elements like ellipses, arcs, and text, 

and the centroid of shapes, line-strings, and B-splines. 

 

Key-In: SNAP <CENTER> 

 

Origin Snap:  

 

 

 

The Origin Snap allows you to snap to the origin of a cell or text, centroid of a B-spline, 

the first data point of a dimension element, or the first vertex of a line, multi-line, line-

string, or shape. 

 

Key-In: SNAP <ORIGIN> 

 

Bisector Snap:  

 

 

The Bisector Snap allows you to snap to the midpoint of an entire line-string, multi-line, 

or complex chain, rather than to the midpoint of the closest segment. It will also snap to 

the midpoint of a line or an arc. 

 

Key-In: SNAP <BISECTOR> 

 

Intersection Snap:  

 

  

The Intersection Snap allows you to snap to the intersection of two elements. 

 

Key-In: SNAP <INTERSECTION> 

 

Tangent Snap:  

Tangent Snap allows you to place lines tangent to a circle, ellipse, or arc. The 

Tangent Snap tentative point slides dynamically around the element to 

maintain tangency until you finish placing the element. 

Key-In: SNAP <TANGENT> 
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Tangent From Snap:  

 

 

The Tangent From Snap works like Tangent Snap, except that the tentative 

point does not move dynamically, but is locked in place. 

 

Key-In: SNAP <TANGENT_FROM> 

 

Perpendicular Snap:  

 

 

The Perpendicular Snap allows you to place lines perpendicularly from another line, a 

circle, ellipse, arc, or shape. The Perpendicular Snap tentative point slides dynamically 

along the element to maintain perpendicularity until you finish placing the element. 

 

Key-In: SNAP <PERPENDICULAR> 

 

Perpendicular Snap Point: 

 

 

The Perpendicular From Snap works like the Perpendicular Snap, except that the 

tentative point does not move dynamically, but is locked in place. 

 

Key-In: SNAP <PERPENDICULAR_FROM> 

 

Parallel Snap: 

 

 

The Parallel Snap allows you to place a line parallel to another line, line segment or 

shape. 

 

Key-In: SNAP <PARALLEL> 

 

Through Point Snap: 

 

 

The Through Point Snap defines a point through which the element you are placing (or an 

extrapolation of it) must pass. 

 

Key-In: SNAP <THROUGH_POINT> 
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Point On Snap:  

 

 

The Point On Snap allows you to snap to the same element wherever you want it placed. 

 

Key-In: SNAP <POINT_ON> 

 

 

Multi-Snaps 1, 2, & 3: 

 

The Multi-Snap buttons allow you to use multiple snaps at once. All three have 

default settings, but the defaults can all be changed. Multi-Snap 1’s default 

setting is Intersection, Keypoint, and Nearest. Multi-Snap 2’s is Intersection, 

Keypoint, and Center. And Multi-Snap 3’s is Midpoint, Intersection, and 

Center. 

 

 

Key-In: SNAP <MULTISNAP1 | MULTISNAP2 | MULTISNAP3> 
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Locks 

This menu has controls that are used to set locks for: Snap, Axis, Unit, Isometric, Grid, 

Levels, Text Nodes, and Graphic Groups. 

 

SETTING LOCKS-FULL SUB-MENU SETTING LOCKS TOGGLES-MENU.  

 

SETTINGS>LOCKS>FULL   SETTINGS>LOCKS>TOGGLES 

 

 

New Graphic Lock menu 

 

Axis Lock 

 

Grid Lock 

 

Unit Lock 

 

Snap Lock 

 

Association Lock 

 

Level Lock 

 

Graphic Group 

 

Text Node Lock 

 

Isometric Lock 

 

Annotation Scale 

 

ACS plane 

 

ACS plane snap 

 

To open locks menu go to Settings menu, choose Locks-Full or Toggle. 

 

Settings and Toggles 

This allows you to adjust various settings as well as toggle locks on and off. 

 

Axis Lock = Ortho 

The START ANGLE is where the angles are measured from. 

The INCREMENT defines where you will allow the element to be placed. 

i.e. Start Angle = 0 and Increment = 90 will allow you to place lines at 0°, 90° and 

270° 
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Group Sub-Palette 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create Complex Chain  

Manual 

1. Select the Create Complex Chain 

tool. 

2. Set method to manual. Identify the 

first element to add to chain. 

3. Continue to identify elements to add 

to chain. 

4. Reset to complete the chain.  

 

 

 

Note: Maximum Gap is the greatest allowable distance between elements when the 

Method is Automatic.  If the Maximum Gap is zero, only elements that connect are added 

 

Key-in: Create Chain Manual  

 

Automatic  

1. Select the Create Complex Chain 

tool. 

2. Set method to automatic. 

3. Identify the first element to add to 

chain. 

4. Identify another point along element 

and it will automatically chain entire line 

 

Key-in: Create Chain Automatic 

Create Complex Chain 

Create Complex Shape 

Create Region 

Add to Graphic Group 

 

Group Hole 

Drop from Graphic Group 

Drop Element 
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Create Complex Shape 

Manually  

1. Select the Create Complex Shape 

tool. 

2. Set method to manual. 

3. Area. 

a. Solid - allows a shape to be filled or 

patterned. 

b. Hole - does not allow a shape to be 

filled or patterned. 

Fill Type 

(When manipulating element, select by edge) 

1. None - creates a shape with no 

existing fill. 

2. Opaque - fills the shape with the selected fill color. 

3. Outlined - fills the shape with the fill color and outlines the shape with the active 

color. 

4. Identify the first element to add to Shape, 

5. Continue to identify elements to add to Shape. 

6. Reset to complete the Shape. 

 

Key-in: Create Shape Manual  

 

 

 Create Complex Shape 

1. Select the Create Complex Shape tool. 

 

 

 

Key-in: Create Shape Automatic 
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Create Region   

1. Select the Create Region tool. 

2.  Set method to Intersection, Union, Difference, or Flood 

(If Keep Original is on, the original elements remain in the 

design file) 

3. Identify the first element 

4. Identify other element(s) 

5. Accept the complex shape(s) 

 

 

Key-in:  Create Region 

 

 

 

 

Intersection - Edges bound the intersection of two or more 

closed, planar elements. 

 

 

 

 

 

 

 

Union - Edges bound the union of two or more closed, planar 

elements. 

 

 

 

 

 
 

 

Difference - Edges bound the difference of two or more 

closed, planar elements. 

 

 
 

 

 

Flood - Edges bound the area enclosed by elements that                 

either touch one another or whose endpoints fall within the 

Maximum Gap 



80 

Graphic Groups 

 

Add to Graphic Group 

 

Add elements to the graphic group one 

by one with Add to Graphic Group tool 

in the Group Sub-palette. 

 

1. Select Add to Graphic Group tool. 

2. Select each element to add to graphic 

group & accept. 

3. Choose next command when done 

 

Key-in: Group Add 

 

To manipulate: 

 

Manipulate with ELEMENT MANIPULATION commands.  May need to UPDATE to 

see manipulation results. 

 

1. Make sure Graphic Group Lock is on. 

2. Choose manipulation command. 

3. Choose one element in Graphic Group. 

4. Follow manipulation command instructions. 

 

Drop from Graphic Group 

1. Select the Drop from Graphic tool. 

2. Set. Use Drop from Graphic Group tool in the 

Group Sub-palette to return to individual elements. 

3. With the graphic group lock on:  Elements are 

manipulated and dropped as a group  

4. With the graphic group lock off:        Elements are 

manipulated and dropped individually. 

  

 

Key-in:  Group Drop 
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Drop Line String/Shape Status 

 

This command is available in two locations: 

 

 

 
 

Or 

 

 
 

1. Select the Drop Line String/Shape Status tool. 

2. Identify the line string or shape. 

3. Accept the drop 

 

     Key-in: Drop String \ Text 

 

 

 

 

 

 

 

 



82 

Modify Palette 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Modify Element Sub-palette 

 

Modify Element 

 

Users can modify an element by: 

1. Select the Modify Element tool. 

2. Identify the element to modify. 

3. Enter data point to make modification. 

4. Reset to finish 

 

      Key-in: Modify Element  

 

Modify Element 

Extend Line 

Trim to Intersection 

Trim to Element 

Trim Multiple 

Insert Vertex 

Delete Vertex 

Construct Parabolic Fillet 

Break Element 

Construct Chamfer 

Construct Circular Fillet 
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Modify Examples 

 

 

Break Element 

 

 

Break by two points 

Users can partial delete an element by: 

1. Select the Delete Part of Element tool. 

2. Identify the element at one end of the part to delete. 

3. Enter data point to define end of open element or enter data for direction for closed 

element. 

4. Enter data point to define end of closed element 

Break by point (Break Element)  

Users can break an Element by: 

1. It is used to break a linear element at a defined point.  It won’t remove any of that 

element just separate it into new elements. 

 

Break by Drag Line Drag a point to break elements (select 1st and 2nd point) 

 

Break by elements Identify the cutting element and then the element to cut 
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Fence Stretch 

Manipulate Fence Contents. 

 

Users can manipulate Fence Contents by: 

 

1. Select the Manipulate Fence Contents tool. 

2. Set operation the Stretch. 

3. Place fence overlapping elements to stretch 

or shorten (works like overlap fence mode). 

4. Enter data point inside the fence to define 

the origin. 

5. Enter data point to reposition the fence and 

the affected vertices 

 

      Key-in: Fence Stretch 

 

Extend Line 

 

Users can extend a line by: 

 

1. Select Extend Line tool. 

2. Identify the line near the endpoint to 

modify. 

3. If Distance is on, accept; if not, data 

point to define length. (Use a negative 

Distance to shorten). 

 

Key-in: Extend Line 

 

 

Trim to intersection Trim Two Elements to Intersection  

 

Users can extend two elements to an intersection by:  

 

1. Select Trim to Intersection Tool. 

2. Identify the elements to intersect and accept. 

 

Key-in: Extend Element 
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Trim to element  

 

Users can extend an element to an intersection by:  

 

1. Select Trim to Element tool. 

2. Identify the element to extend 

or shorten. 

3. Identify the element 

to extend or shorten to and 

accept it. 

 

Key-in: Extend Element Intersection 

Trim Element  

 

Users can trim an element by: 

 

1. Select Trim Element tool. 

2. Identify the cutting element. 

3. Identify an element to trim (The element is highlighted and how it will be 

trimmed is dynamically displayed). 

4. Data to accept the trimmed element. 

5. Identify another element to trim or reset to finish.  

Key-in: Trim Element 

 

 

 

Insert Vertex  

 

Users can insert a vertex on an element by: 

 

1. Select the Insert Vertex tool. 

2. Identify the segment on which to add vertex. 

3. Enter data point to position the new vertex. 

 

       

 

Key-in: Insert Vertex 

Option to inverse selection order 
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Delete Vertex 

Users can delete a vertex on an element by: 

 

1. Select the Delete Vertex tool. 

2. Identify the vertex or extension line. 

3. Accept the deletion 

 

   Key-in: Delete Vertex 

 
 

Fillet Sub-Palette Construct Circular Fillet tool   

 

Fillet  

1) Select the Construct Circular Fillet tool. 

2) Identify the first element or segment. 

3) Identify the second segment. 

4) Accept the fillet. 

 

 

 

 

 

 

Construct Chamfer    

 

 

1)   Select the Construct Chamfer tool 

2)   Identify the first line or segment 

3)   Identify the second line or segment 

4)   Data point to accept the chamfer 

 

Key-in: Chamfer 

 

 

Construct Parabolic Fillet: Used 

to construct a parabolic fillet (curve 

element) between two lines   



87 

CHAPTER 4 

MicroStation 5 Sub-palette (In MDT Custom Palette) 

 

To open the menu, go under the MDT pull down menu, select MDT CUSTOM then 

select MICRO 5. 

 

Construct Tangent Arc by Radius 

 

 

1. Select Construct Tangent Arc by Radius 

Tool. 

2. Fill in desired Radius and Length. 

3. Identify line to construct arc on. 

4. Move to the side of line to construct arc on. 

5. Data Point to accept arc. 

 

Key-in: Construct Tangent Arc 1 

 

 

Construct Arc Tangent to Three Elements 

 

1. Select Construct Arc Tangent to 3 Elements 

tool. 

2. Identify the three elements. 

3. Data Point to accept and show direction of 

arc. 

 

 

Key-in: Construct Tangent Arc 3 

 

 

Construct Line Bisector 

 

1. Select Construct Line Bisector Tool. 

2. Identify line to bisect. 

3. Data point to define length. 

 

 

 

Key-in: Construct Bisector Line  
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Construct Circle Tangent to Element 

 

1. Select Construct Circle 

Tangent to Element tool. 

2. Identify element. 

3. Data Point to define center of 

circle. 

  

 

 

 

 

Area 

1. Solid - allows a shape to be filled or patterned. 

2. Hole - does not allow a shape to be filled or patterned. 

3. Fill Type.  (When manipulating element, select by edge). 

a. None - creates a shape with no existing fill. 

b. Opaque - fills the shape with the selected fill color. 

c. Outlined - fills the shape with the fill color and outlines the shape with the 

active color. 

Fill Type 

(When manipulating element, select by edge) 

 

1. None - creates a shape with no existing fill. 

2. Opaque - fills the shape with the selected fill color. 

3. Outlined - fills the shape with the fill color and outlines the shape with the active 

color. 

 

Key-in: Construct Tangent Circle 1 

Construct Circle Tangent to Three Elements 

 

 

1. Select Construct Circle Tangent to 3 

Elements tool. 

2. Identify the three elements. 

3. Data Point to accept. 

 

 

 

 

 

 

Key-in: Construct Tangent Circle 3 
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Construct Perpendicular to Element 

 

 

1. Select Construct Perpendicular to 

Element tool. 

2. Identify element at point of 

intersection. 

3. Data Point to define length. 

 

Key-in: Construct Perpendicular To 

 

 

 

Construct Perpendicular from Element 

 

1. Select Construct. 

2. Perpendicular from Element tool. 

3. Identify element. 

4. Data Point to define point of 

intersection and length. 

 

Key-in: Construct Perpendicular From 

 

 

 

Construct Tangent to Element 

 

 

1. Select Construct Tangent to Element 

tool. 

2. Identify element. 

3. Data Point to define length and 

direction. 

 

 Key-in: Construct Tangent to Element 
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Construct Tangent from Element 

 

 

1. Select Construct Tangent from 

Element tool. 

2. Identify element at point of 

intersection. 

3. Data Point to define length. 

 

 Key-in: Construct Tangent From 

 

 

 

Label Line 

 

1. Select Label Line tool. 

2. Identify element. 

3. Data Point to accept. 

 

 

 

 

 

 

 

 

 

 

NOTE: For labeling Bearing with DDMMSS 

Settings > Design file > Angel readout > Azimuth or Bearing choice 
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Linear Elements Sub Palette 

 

 

 

 

 

 

Place SmartLine 

 

 

 

 

Select Place SmartLine Tool. 

1. Select the Segment Type. 

a. Line - to create line segments. 

b. Arc - to create arc segments. 

 

 

 

 

2. Select the Vertex Type. 

a. Sharp - no rounding or chamfering. 

b. Rounded - Rounds vertex by radius specified. 

c. Chamfered - Chamfers vertex by offset specified. 

 

 

 

3. Toggle Join Elements on/off. 

a. On - The segments will create a closed chain upon 

snapping to the first vertex point. 

i. Toggle Closed Element on/off. 

ii. On - Select Area Type, Fill Type     and color. 

b. Off - The segments will remain separate elements 

that may have different symbology. 
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Construct Angle Bisector  

 

 

 

 

 

1. Select Construct Angle Bisector tool. 

2. Identify one endpoint of the angle. 

3. Identify the vertex of the angle. 

4. Identify the second endpoint. 

 

Key-in: Construct Bisector Angle 

Construct Minimum Distance Line 

 

 
 

1. Select Construct Minimum Distance Line tool. 

2. Identify the elements to draw between and accept. 

 

Key-in: Construct Line Minimum 

Construct Line at Active Angle 

 

 

 

 

 

 

 

 

 

1. Select Construct Line at Active Angle tool. 

2. Identify the element to intersect. 

a. If the Method is From Point, this data point defines the intersection point. 

3. Enter a data point. 

a. If the Length is off, this data point defines the length. 

b. If the Method is To Point, this data point defines the intersection. 

 

Key-in: Construct Line AA 
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Levels 

View Levels 

When working at MDT it is important to remember that every time you place a different 

type of element, that element type will have its own level. Fences, culverts, lines on the 

road, wetlands, utility lines, and even cattle guards have their own levels. There are many 

ways to navigate between levels and the options within levels.  

 

The easiest way to navigate is probably using 

the Level Display. To open the Level Display 

Dialog Window, simply click on the Level 

Display button in the Primary Tool bar, or 

open the Settings menu, highlight “Level” 

until the drop-down menu opens and select 

“Display.”  You can also type “Ctrl E” on the 

key board.  All three will open the Level 

Display.  

 

There are several features of the Level Display 

Dialog Window that are quite helpful. One of 

the most helpful features is probably the 

Levels/Filters option menu. On the Levels 

setting you can see a list of all the possible 

levels, complete with information such as the level name, level number, seed file type, 

use status, and more. You can also see which level the active level is (the one currently in 

use as opposed to any level that has been used in the design file), as it is highlighted in 

green. The Blue highlights indicate level is turned on.  The White highlight indicate 

levels turned off.  The Green highlight indicates that the level is the active level. 

The Filters setting are filters used by individual sections such as Road Design or 

Photogrammetry.  These filters have only specific levels associated with specific 

sections. 

The view toggles in the dialog window are another useful feature that allows you to apply 

different levels to each view and makes it possible to look at several different options at 

once. The view toggles are in the View Display drop down menu. The drop-down menu 

should be left on its default setting when working on design files; the Global Freeze and 

Global Display options are not used at MDT. 
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Single Click - Turns levels off & on.  Double Click - Changes active level. 

To turn “On” & “Off” multiple levels at onetime - Hold down the data button on the 

mouse and pull down or up across levels. 

Active 

Level 

Level is 

turned 

on 

Level is 

turned 

off 
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Standard Levels 

Each area has set up standard levels for different sections of designs.  Check the design 

manual for your area. 
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Level Manager 

Using the Level Manager is another way 

to navigate through the level tools. It 

does essentially all the same things that 

Level Display does in a slightly different 

format. You can open the Level Manager 

by clicking the Settings menu, highlight 

“Level” until the drop-down menu opens. 

When the drop-down menu opens, 

choose “Manager.”  A second way is to 

click on the Level Display button in the 

Primary Tool bar 
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Key-ins: 

 

1. Lv = Active Level (i.e. lv=225 or name) 

2. On = Turns on Levels (i.e. on=1-10 or name) 

3. Of = Turns off Levels (i.e. of=10-20 or name) 

 

 

 

 

Setting Locks Sub-menu 

 

1. Toggle On/off (Default Off). 

2. Fence manipulations affect all levels on. 

3. Element manipulations affect only Active Level. 

 

 

Key-in: Lock Level On/Off 
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CHAPTER 5 

CELLS 

Cells Sub-palette 

 

 

 

 

 

 

 

 

 

To open the Cell Library menu, go to Element > Cells 

 

 
 

 

 

 

 

Place Active Cell 

Place Active Cell Matrix 

Select and Place Cell 

Define Cell Origin 

Identify Cell 

Place Active Line Terminator 

Replace Cells 

Place Cell Index 
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Cell Library File pull down menu. 

 

1. Attach Existing Cell Library.  This menu is used to attach existing cell libraries.  

Usually will attach from CADD Standards drive (W:drive).  However, one can 

attach from any drive currently available on the PC. 

2. Create New Cell Library. Used to create new cell libraries.  This cannot be 

created on CADD Standards drive (W: drive). 

3. Compress - Compress Cell Library.  Used to save changes to cell library. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Explanation of Cell Types and Their Properties 

 

Graphic and Point Cells   

 

1. Cc=Name (<=6 Char, no spaces), Description (<=27 Char), Type [P or Blank 

(Defaults to G)]. 

2. *Active Settings (Angle (AA), Scale (As), Line Code (Lc), Color (Co) and 

Weight (Wt) Affects Cell Upon Creation. 

 

Graphic Cells 

 

1. Placement Can Be Relative (Placed on Active Level) or Absolute (Placed on 

Level Cell Was Created On). 

2. Active Angle and Active Scale Affects Cell Upon Placement. 

3. Always Placed by Origin. 

4. Can Snap to Individual Elements in the Cell. 
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Point Cells 

 

1. Placement Always Relative (Always Placed on Active Level). 

2. Active Line Code, Color and Weight Affects Cell Upon Placement. 

3. Can Only Snap to Cell Origin. 

 

 

Procedure for Creating a Cell  

 

1. Draw Element(s). 

2. Place Fence (Inside or Overlap Lock) Around Element(s) or use Element Select 

tool. 

3. Select Define Cell Origin Tool from Cell Library menu. 

4. Enter data point to define cell origin. 

5. Reset to accept cell origin. 

 

What is a Cell Origin?  Each cell has a cell origin, defined at the time of the creation of 

the cell.  This point of origin is the “handle” of the cell.  By entering a data point to place 

the cell, the origin is placed at that point.  We refer to this point as the point of insertion. 

 

Key-in: Define Cell Origin 

 

 

 

 

 

Create Cell 

Click on the Create... command button.  

 

(Create New Cell Input Box Is 

Displayed). 
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Create New Cell Input Box 

 

 

1. Enter name (no spaces) in Name: Field. 

2. Enter description in Description: Field. 

3. Select cell type (Graphic or Point (see page 5-2 for definitions)) from cell type 

drop down menu list (Default is Graphic). 

4. Click on Create button to create cell.  The new cell is placed in the cell library. 

 

Key-in: Cc=Name, Description, Type 

(Eg.:  AC=House, origin Lower Left Corner@) 

 

Cell Tool Box Main 

 

Place Active Cell   

 

Note: 

Cell selected for placement in [Settings Cells 

Sub-menu] (shown at left) will automatically be 

displayed in Active Cell field of Place Active 

Cell or Place Active Cell Matrix tool settings. 

 

 

 

 

 

 

To place an active cell. 

1. Select Place Active Cell tool. 

2. Fill in appropriate information, if necessary. (Active Cell name, Active Angle, X 

Scale, and Y Scale). 

3. Toggle Interactive On to Place Active Cell at other than Active Scale or Active 

Angle (enter two data points to define scale and rotation angle). 

4. Toggle Relative On to Place Graphic Cell on Active Level. 

5. Enter data point to position cell origin. 

6. Reset to finish. 

 

Key-in: Place Cell Icon 
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Place Active Cell Matrix 

 

1. Select Place Active Cell Matrix tool. 

2. Fill in appropriate information: (Active Cell 

name, Number of Rows, Number of Columns, 

Row Spacing, and Column Spacing). 

3. Enter data point to position cell matrix. 

 

    Key-in: Matrix Cell 

 

 

 

 

Example Matrix Cell 

 

This cell matrix was made with 4 rows 3 columns 2 feet between rows and 4 feet between 

columns. 

 

1. Select cell as active cell. 

2. Set cell matrix rows and column 

information using Matrix Cell key-in. 

3. Place a data point to indicate the 

origin of the lower left cell (matrix origin). 

 

 

 

 

 

 

 

Select and Place Cell  

1. Select the Select and Place Cell tool. 

2. Data to identify an existing cell in the design file. 

3. Fill in appropriate information:(Active Angle, X 

Scale, and Y Scale). 

4. Enter data point to position the copy of the cell. 

5. Reset to finish. 

 

    Key-in: Select Cell Icon 
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Identify Cell  

 

1. Select Identify Cell tool. 

2. Data to identify cell. 

3. Data to accept the cell.  (Cell name and level 

are displayed in the Command Window). 

 

    Key-in: Identify Cell 

 

Replace Cell  

 

1. Place “dummy” cell in design file. 

2. DROP status on “dummy” cell. 

3. Make changes to the elements. 

4. Either rename cell in cell library ( if you 

want to keep the original ) or you can delete the 

cell from the library. 

5. Create a cell out of dummy copy with 

SAME NAME and ORIGIN POINT as old cell. 

6. Select Replace Cell tool. 

7. Data to identify cell. 

8. Data to accept the replacement. 

 

Note: If the identified cell is shared, all instances of the cell in the design are replaced. 

If the identified cell is unshared, only the identified cell is replaced. 

 

Key-in: Replace Cell 
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Place Line Terminator  

 

1. Select Place Active Line Terminator tool. 

2. Enter terminator cell name and scale. 

3. Identify element near endpoint where terminator is to be placed. 

4. Data to accept line terminator. 

 

Note: 

Cell selected as terminator in [Settings Cells Sub-menu] will automatically be displayed 

in Terminator field of Place Active Line Terminator tool settings. 

 

Key-in: Place Terminator 

 

Examples Of Line Terminators 

 

 

These line terminators were made using 

the place line terminator palette to place 

arrow cells with different origins at 

different termination points. 
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Deleting a Cell 

1. Select the Cell to be deleted from the Cell Name listing in the [Element > Cells]. 

2. Select Delete Cell Command From [Element > Cells]. (Causes Alert Input Box to 

Be Displayed). 

3. Click on the OK button to Delete the Cell. (Deletes Cell from Library). 

4. Click on the Cancel button to Cancel Deletion. 

 

Key-in: Cd=delete Cell 

 

 

 

 

 

 

Renaming Cell 

1. Select the Cell to be renamed from the Cell Name listing. 

2. Select Edit Cell Command From. 

Edit Cell 

Edit Cell Information Input Box 

 

1. Click on the Edit... command button. 

(Edit Cell Information Input Box Is 

Displayed). 

2. Edit Cell Information Input Box. 

3. Enter New name (no spaces) in Name: Field if 

applicable. 

4. Enter New description in Description: Field if applicable. 

5. Click on Modify button to modify cell information. 

 

Key-in: Cr=Oldname, Newname 
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POINTS PALETTE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Points Tool Box Main 

General Points Sub-Palette Fields: 

 

Point Type: Element places point element. 

Character places single character. Cell places cell. 

Character: Single Character to be placed 

(Used with Character Point Type).  

Cell: Name of Cell to be placed 

 (Used with Cell Point Type). 

 

 

Place Active Point 

1. Select Active Point tool. 

2. Select Point Type and enter Character or Cell 

information if applicable. 

3. Enter data point to position Active Point. 

4. Reset to finish. 

 

 

Key-in: Place Point 
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Examples Of Active Point Placement 

 

These active points were placed using the Place Active 

Point palette to place point elements, point cells (trees) 

and point characters (A and B) at different active points. 

 

Note: Point elements do not plot.  However, cells and 

characters do plot. 

 

 

 

 

 

 

 

 

 

Construct Active Point Between Data Points 

1. Select Construct Active Point 

Between Data Points tool. 

2. Select Point Type and enter 

Character or Cell information if 

applicable. 

3. Determine number of points.  

(Enter number of points to construct 

in Points: field). 

4. Data point to define first 

Active point. 

5. Second data point to define 

last active point. 

6. Reset to finish. 

 

Key-in: Construct Point Between 
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Project Active Point onto Element   

1. Select Project Active Point onto 

Element tool. 

2. Select Point Type and enter 

Character or Cell information if 

applicable. 

3. Identify element. 

4. Data point to project the Active 

Point. 

 

Key-in: Construct Point Project 

 

Construct Active Point at Intersection  

1. Select Construct Active Point at 

Intersection tool. 

2. Select Point Type and enter 

Character or Cell information if 

applicable. 

3. Identify first element close to desired 

intersection. 

4. Data to accept the construction. 

 

 

Key-in: Construct Point Intersection 

 

Construct Active Points Along Element  

1. Select Construct Active Point Along 

Element tool. 

2. Select Point Type and enter Character or 

Cell information if applicable. 

3. Determine number of points. 

4. Identify element to define one end of 

segment on which to construct Active Point. 

5. Data point to define the other end of 

segment. 

 

Key-in: Construct Point Along  
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Construct Active Point at Distance Along Element 

1. Select Construct Active Point 

at Distance Along Element tool. 

2. Select Point Type and enter 

Character or Cell information if 

applicable. 

3. Determine distance.  (Enter 

distance along element to 

construct point in Distance: 

field). 

4. Identify element at point to 

measure the distance from. 

5. Data point to define 

direction. 

 

 

Key-in: Construct Point Distance 
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MEASURE PALETTE 

 

 

 

 

 

 

 

Measure Cumulative Distance from an Origin 

1. Select Measure Distance tool. 

2. Set Distance to Between Points. 

3. Data point to define origin. 

4. Second data point at point to be measured. 

The measurement is displayed in the command 

window. 

5. Enter another data point(s). The cumulative 

distance from the origin is displayed in the 

command window. 

6. Or reset to return to step 3. 

 

Key-in: Measure Distance Points 

 

Measure Distance Along Element 

1. Select Measure Distance tool. 

2. 2) Set Distance to Along Element. 

3. 3) Identify element at origin. 

4. 4) Data point to define point along element. 

The measurement is displayed in the command 

window. 

 

Key-in: Measure Distance Along 

Measure Distance 

Measure Radius 

Measure Angle 

Measure Length 

Measure Area 

Measure Volume 
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Measuring with Perpendicular Snap 

 

When measuring with the Perpendicular snap the setting Segment Only option needs to 

be on to snap to an element beyond the first element measured.   

 

 
 

 

Measure Perpendicular from an 

Element 

1. Select Measure Distance tool. 

2. Set Distance to Perpendicular. 

3. Identify element. 

4. Data point at point to be measured. 

The measurement is displayed in the 

command window. 

5. Reset to finish. 

 

Key-in: Measure Distance Perpendicular 

 

Measure Minimum Distance Between 

Elements  

1. Select Measure Distance tool. 

2. Set Distance to Minimum Between. 

3. Identify first element. 

4. Identify second element. 

5. Data to accept the elements. The 

measurement is displayed in the command 

window. 

 

Key-in: Measure Distance Minimum 
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Measure Maximum Distance Between Elements  

 

1. Select Measure Distance tool. 

2. Set Distance to Minimum Between. 

3. Identify first element. 

4. Identify second element. 

5. Data to accept the elements. The 

measurement is displayed in the command 

window. 

 

Key-in: Measure Distance Minimum 

 

Measure Radius  

1. Select Measure Radius tool. 

2. Identify Element or segment. 

3. Data to accept the element. The 

measurement is displayed in the command 

window. 

 

 

 

 

Key-in: Measure Radius 
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Measure Angle Between Lines  

1. Select Measure Angle Between 

Lines tool. 

2. Identify first line. 

3. Identify second line. 

4. Data to accept the lines. The 

measurement is displayed in the 

command window. 

 

Key-in: Measure Angle 

 

 

 

Measure Length 

 

1. Select Measure Length tool. The Tolerance 

(%) is used when measuring curves.  It represents 

the maximum allowable percentage of the 

distance between the true curve and the 

approximation used to measure the curve.  A low 

tolerance makes the measurement more accurate 

but increases the calculation time. If Mass 

Properties is toggled on, the Mass Properties 

window displays the mass property analysis.  

 

Default Properties:  Length, Mass, and Centroid. 

Properties Toggled On Under Display Menu: 

Moments and Properties of Inertia; Principal Moments and Directions; and Radii of 

Gyration. If Display Centroid is toggled on, a graphic crosshair that represents the 

center of mass for the measured element(s) is displayed. 

2. Identify element. 

3. Data to accept element. The measurement is displayed in the command window. 

 

Key-in: Measure Length 
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Measure Area and Perimeter of One Element  

 

1. Select Measure Area tool. Mass Properties 

Same as For Length except, Default Properties. 

Perimeter, Surface Area, Mass, and Centroid. 

2. Set Method to Element. 

3. Identify element. 

4. Data to accept element. The measurement is 

displayed in the command window). 

 

 

 

 

 

Key-in: Measure Area Element 

 

 

 

Measure Area Defined by Fence 

 

1. Use Place Fence or Place Fence Shape tool. 

2. Select Measure Area tool. 

3. Set Method to Fence. 

4. Data to accept the measurement. The 

measurement is displayed in the command 

window. 

 

 

 

 

Key-in: Measure Area Fence 
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Measure Area of Intersection of Closed Elements 

 

1. Select Measure Area tool. 

2. Set Method to Intersection. 

3. Identify Elements. 

4. Data to accept. 

5. Reset to display area in command window. 

 

 

 

Key-in: Measure Area [Intersection] 

 

 

 

 

Measure Area of Union of Closed Elements 

 

1. Select Measure Area tool. 

2. Set Method to Union. 

3. Identify Elements. 

4. Data to accept. 

5. Reset to display area in command window. 

 

 

 

 

Key-in: Measure Area [Union] 

 

 

 

Measure Area of Difference Between Elements   

 

1. Select Measure Area tool. 

2. Set Method to Difference. 

3. Identify Element from which to subtract. 

4. Identify Element(s) to subtract. 

5. Data to accept. 

6. Reset to display area in command window. 

 

 

Key-in: Measure Area Difference 
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Measure Area Enclosed by Elements that Touch  

 

NOTE: To minimize computing time, zoom 

in to the area of interest or select the bounding 

elements before selecting the command. 

 

1. Select Measure Area tool. 

2. Set Method to Flood. 

3. Data point in area enclosed by the bounding 

elements. 

4. Data to accept the measurement. The 

measurement is displayed in the command 

window. 

 

 

Key-in: Measure Area Flood 

 

 

 

 

 

 

 

Measure Area Defined by Data Points 

1. Select Measure Area tool. 

2. Set Method to Points. 

3. Data point to define each vertex of shape 

that encloses the area. 

4. Reset when done. The measurement is 

displayed in the command window. 

 

 

 

Key-in: Measure Area Points 
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Measure Volume [3D Command Only] 

 

1. Select Measure Volume tool. 

2. Mass Properties Same as For Length except, 

Default Properties:  Perimeter, Volume, Mass, 

and Centroid. 

3. Identify element. 

4. Data to accept element. The measurement is 

displayed in the command window. 

 

Key-in: Measure Volume 

Volume unit options: 
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Various MicroStation Key-ins 
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XY = X Coordinates, Y Coordinates 

 

1)   Needs Coordinates X, Y 

 

2) Use like Any Data Point 

 

 

 

 

 

 

DL = Distance X, Distance Y 

 

1)   DL = 10, 15 

 

2)   Distance X - 10 Master Units 

 

3)   Distance Y - 15 Master Units 

 

3) From a Point or Tentative 

 

4)  Can Put in Negative Values 

 

 

 

DI = Distance, Direction 

 

1)   Di = 5,30 

 

2)   Distance - Working Unit (5 Master 

Units) 

 

3)   Direction - Angle (30 = Thirty Degrees) 

 

              4)   Can Put in Negative Values 

 
 

Go to Lab 5 to continue precision input. 
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CHAPTER 6 

PATTERNING PALETTE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: 

1. Where there is spacing required, make sure you have a number other than zero 

entered or you will have an unusable file. 

2. If Associative Pattern is turned on, when the element is manipulated the pattern 

will automatically adjust to the new shape. 

3. If “Snappable Pattern” is turned on, “Snappable” points will be included as part of 

the pattern. 

 

Hatch Area Inside Closed Element  

 

1. Select Hatch Area command. 

2. Set Method to Element. 

3. Identify Element. 

4. Data point to define a point through which a 

hatch line must pass. 

 

 

    Keyin: Hatch Element 
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Hatch Area Between Multi-Line Components  

 

1. Select Hatch Area command. 

2. Set Method to Element. 

3. Identify one component to be boundary of 

hatched area. 

4. Identify the other component to be boundary 

of hatched area. If Associative Pattern is off, this 

data point defines a point through which one of 

the hatch lines must pass. If Associative Pattern is 

on, the hatch pattern is associated with the multi-

line and one of the hatch lines must pass through 

one of the multi-line=s vertices. 

5. Press Reset 

 

Keyin: Hatch Element 

 

Hatch Fenced Area  

 

1. Select Hatch Area command. 

2. Set Method to Fence. 

3. Data point to define a point through which a 

hatch line must pass 

 

 

 

 Keyin: Hatch Fence 
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Hatch Intersection or Union of Closed Elements  

 

1. Select Hatch Area command. 

2. Select the elements. 

3. Set Method to Intersection or Union. 

4. Data point to define a point through which a 

hatch line must pass. 

5. Reset to complete 

 

  

Keyin: Hatch Union or Intersection 

 

 

 

 

 

 

 

 

 

Hatch Area Difference Between Elements   

 

1. Select Hatch Area command. 

2. Set Method to Difference. 

3. Identify Element from which to subtract. 

4. Identify Element(s) to subtract. 

5. Reset to complete. 

 

 

 Keyin: Hatch Difference 
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Hatch Area Enclosed by Bounding Elements   

Note: Max Gap is the maximum space 

between elements.  If the gap between elements 

is larger than this value, it will continue to 

search the file until it hits the edge of the 

design file.  To minimize computing time to 

find the elements, zoom into the area of interest 

or select the bounding elements before 

selecting command. 

 

1. Select Hatch Area command. 

2. Set Method to Flood. 

3. Enter a data point in the area enclosed by 

bounding elements. 

4. Accept the hatching. 

 

 

 Keyin: Hatch Flood 

 

 

 

Hatch Area Defined by Data Point  

 

1. Select Hatch Area command. 

2. Set Method to Point. 

3. Data point to define each vertex of shape 

that encloses the area. 

4. Reset to complete. 

 

 

 

 Keyin: Hatch Points 
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Crosshatch Area  

 

 

Command settings and procedures are the same as 

Hatch Area commands except that an additional 

spacing and angle must be defined.  Note: Do not 

use spacing =0 and use different angles so that 

cross hatch will appear. 

 

 

 

 

Pattern Area Inside Closed Element  

 

 

1. Select Pattern Area command. 

2. Set Method to Element. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will 

blow up your design file! 

4. Identify Element. 

5. Data point to place the origin of the pattern 

cell. 

 

 Keyin: Pattern Area Element 

 

 

 

 

 

 

 

 

 
 

 

 

Pattern Area: Pattern an area by tiling the active pattern cell/definition. 

Linear Pattern: Place active pattern cell along an element. 

Show Pattern Attributes: Display the pattern angle and pattern scale of a pattern element. 

Match Pattern Attributes: Change the active pattern attributes to match those of an existing pattern element. 

Change Pattern: Change pattern/hatch properties. 

Delete Patterning: Delete patterning
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Pattern Intersection or Union of Closed Elements 

 
1. Select Pattern Area command. 

2. Set Method to Intersection or Union. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will 

blow up your design file! 

4. Select the closed elements. 

5. Enter Data point away from elements. 

6. Reset to complete. 

 

 

 Keyin: Pattern Area Intersection or Union 

 

 

 

 

 

 

Pattern Fenced Area   

 

1. Select Pattern Area command. 

2. Set Method to Fence. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will 

blow up your design file! 

4. Data point to place the origin of one of the 

pattern cell instances. 

 

 

 Keyin: Pattern Area Fence 
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Pattern Area Difference Between Elements  

 

1. Select Pattern Area command. 

2. Set Method to Difference. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will blow 

up your design file! 

4. Identify Element from which to subtract. 

5. Identify Element(s) to subtract. 

6. Reset to complete. 

 

 

Keyin: Pattern Area Difference  

 

 

 

 

 

Pattern Area Enclosed by Bounding Elements  

Note: Max Gap is the maximum space between elements.  If the gap between elements is 

larger than this value it will continue to search the file until it hits the edge of the design 

file.  To minimize computing time to find the elements, zoom into the area of interest or 

select the bounding elements before selecting command. 

 

1. Select Pattern Area command. 

2. Set Method to Flood. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will blow 

up your design file! 

4. Data point area enclosed by bounding 

elements. 

5. Accept the patterning. 

 

 

Keyin: Pattern Area Flood 
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Pattern Area Defined by Data Point   

 

1. Select Pattern Area command. 

2. Set Method to Point. 

3. Fill in Pattern cell name, scale, spacing & 

angle. Note: Never use scale = 0.  This will 

blow up your design file! 

4. Data point to define each vertex of shape 

that encloses the area. 

5. Reset to Complete. 

 

 

 Keyin: Pattern Area Points 

 

 

 

 

 

Single-cycle Segment Linear Pattern   

 

1. Select Linear Pattern command. 

2. Set Cycle to Single. 

3. Fill in Pattern cell name & scale.  Note: 

Never use scale = 0.  This will blow up your 

design file! 

4. Data point to select element. 

5. Data point to indicate pattern direction. 

6. Only One Cell per Segment. 

7. Original Element Replaced by Pattern. 

 

 Keyin: Pattern Line Single 
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   Multi-cycle Segment Linear Pattern   

Select Linear Pattern command. 

1. Set Cycle to Multiple. 

2. Fill in Pattern cell name & scale. Note: 

Never use scale = 0.  This will blow up your 

design file! 

3. Data point to select element. 

4. Data point to indicate pattern direction. 

5. All Cell Scale on Each Segment. 

6. Original Element Replaced by Pattern. 

 

Keyin Pattern Line Multiple 

 

 

 

Truncated Cycle Linear Pattern  

1. Select Linear Pattern command. 

2. Set Cycle to Truncated. 

3. Fill in Pattern cell name & scale. Note: 

Never use scale = 0.  This will blow up your 

design file! 

4. Data point to select element. 

5. Data point to indicate pattern direction. 

6. All Cell Original Size. 

7. Original Element Replaced by Pattern. 

 

 Keyin: Pattern Line Element 

 

Complete Cycle Linear Pattern   

1. Select Linear Pattern command. 

2. Set Cycle to Complete. 

3. Fill in Pattern cell name & scale.  Note: 

Never use scale = 0.  This will blow up your 

design file! 

4. Data point to select element. 

5. Data point to indicate pattern direction. 

6. All Cells Scale So There Are No Partial 

Cells. 

7. Original Element Replaced by Pattern. 

 

 Keyin: Pattern Line Scale 



131 

Show Pattern Attributes   

 

1. Select Show Pattern Attributes command. 

2. Identify pattern element. 

3. Accept pattern element. 

 

 

Keyin: Show Pattern 

 

Match Pattern Attributes  

 

1.Select Match Pattern Attributes command. 

2.Identify pattern element. 

3.Accept pattern element. 

 

 

Keyin: Active Pattern Match 

 

Change Pattern Attributes 

 

1. Select Change Pattern command. 

2. Identify pattern to use for settings. 

3. Accept change. 

 

 

Keyin: Modify Pattern 

 

Select “Pattern Parameters” to use current line 

spacing. 

 

Delete Pattern  

 

1. Select Delete Pattern command. 

2. Identify pattern to delete. 

3. Accept deletion. 

 

Keyin: Delete Pattern 
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LINEAR PATTERNING EXERCISE 

 
1. Place a line string. 

2. Copy three times. 

3. Set attributes: 

a. Pattern cell name = PGR [Proposed guardrail.] 

b. Pattern Scale =1. 

4. Select command. 

a. 1st data point. 

b. 2nd data point accepts and indicates direction of pattern flow. 

 

 

In Command Window in the special messages area A Pattern Task Initiated will appear. 

 

EXAMPLES OF PATTERN PROCESS COMPLETE or PATTERN INTERSECTIONS 
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CHAPTER 7 

TEXT MENU 

 

Text Sub-Palette 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Place Text 

Place Note 

Edit Text 

Spell Checker 

Display Text Attributes 

Match Text Attributes 

Change Text Attributes 

Place Text Node 

Copy/Increment 

Text 
Copy Enter Data Field 

Copy/Increment Enter Data Fields 

Fill in Single Enter-Data Field 

Auto Fill in Enter Data Fields 

Change Case 
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Place Text 

To place text in a file: 

 

 

1. Select Place Text 

command. 

2. Set Method to By 

Origin. 

3. In the Text Editor, 

type the text. 

4. Enter a data point to 

position the origin of the 

text element 

 

     Key-in: Place Text 
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Change Text Attributes 

 

To change the text attributes: 

1. Select Change Text to Active 

Attributes command. 

2. Identify and accept the text 

 

Key-in: Modify Text 

 

 

Height & Width 

 

Sets the size of the characters & can be locked to 

keep the same for both dimensions 

 

Keyin: TH = Text Height (File Designable) 

                   TW = Text Width (File Designable) 

                   TX = Text Size (File Designable). 

 

Font 

Refers to the type of text character 

Keyin:    FT = Active Font (File Designable) 

Justification 

Sets the justification of placement of the font. 
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Line Spacing 

Sets the space between 

multiple lines of text. 

Keyin:     LS = Line 

Spacing (Generally about 

Half Text Height) (File 

Designable) 

Menu: Under Element > 

Text styles 

 

Length 

Sets the maximum number of characters allowed on one line. 

Keyin:     LL = Line Length (File Designable) (Max. Length = 

255 Characters)  

View 

(Active text settings are set in the Text Settings box.) 

1)  Opens the Font dialog box to view the available 

fonts 

Keyin:     DF = View Available Fonts 
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Text Editor 

Edit Text 

 

To edit the text: 

1. Data point on text to edit and accept. 

2. The Text Editor window will open. 

3. Make changes, click in drawing to accept. 

 

Key-in: Edit Text 

 

Placed Fitted Text 

 

 

To place fitted text: 

 

1. Select Place Text command. 

2. Set Method to Fitted. 

3. In the Text Editor, type the text. 

4.  Enter a data point to define the left 

end of the fitted text. 

5. Enter a data point to position the 

right end of the text and define the 

height, width, and rotation angle (This 

interactively places text) 

 

Key-in: Place Text Fitted 

 

Key-in: Place Text Fitted 
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Place Text above/below Element 

To place text above and below an element: 

 

1. Select Place Text command. 

2. Set Method to Above Element or 

Below Element Note: For line elements 

only. 

3. In the text editor, type text. 

4. Identify the line segment. 

5. Accept the text 

 

     Key-in: Place Text Above/Below 

 

 

 

 

 

 

 

 

 

 

 

 

 

Place Text on Element 

To place text on an element: 

1. Select Place Text command. 

2. Set Method to “On Element” Note: 

For line elements only. 

3. In the text editor, type text. 

4. Identify the element on which to 

place text and accept 

 

     Key-in: Place Text On 
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Place Text along Element 

To place text along an element: 

1. Select Place Text command. 

2. Set Method to “Along Element” 

Note: For curve elements only. 

3. In the Text Editor, type text. 

4. Enter a data point along the element 

to position the origin. 

5. Enter a data point to position the text 

above or below the element 

 

     Key-in: Place Text Along  

 

 

 

Place Note 

 

To place a note on an element: 

1. Select Place Note command. 

(NOTE: Text settings are determined 

by dimension attributes). 

2. In the Text Editor, type text. 

3. Enter a data point to position the 

arrowhead. 

4. Enter a data point to define leader 

line 

 

Key-in: PLACE NOTE 
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Copy & Increment Text  

To copy and increment text: 

 

1. Select Copy and Increment Text 

command. 

2. Set the tag increment (between 1 and 

32767). 

3. Identify the text element to copy and 

increment Note: Text must contain a 

number to increment. 

4. Enter a data point to position text 

 

Key-in: Increment Text 

 

 

Place Text Node 

To place a text node: 

 

1. Select Place Text Node command. 

2. Enter a data point to position node 

 

 

  

 

Match Text 

To match text attributes: 

1. Select Match Text Attributes command. 

2. Select a text element and accept 

 

Use with *“Change text attributes” command to 

change existing text to the text just matched. 

 

     Key-in: Active Text  
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Display Text Attributes 

To display text attributes: 

1. Select Display Attributes of Text Element 

command. 

2. Identify and accept the text element. 

3. Special message area in Command Window 

will display the text attributes  

 

     Key-in: Identify Text 

 

 

 

NOTE: To see these make sure Data Fields is turned on in View Attributes. 

 

Place Enter Data Fields  

To place enter data fields: 

 

1. Select Place Text command.  Note: 

The active text settings at the time the 

Enter Data Fields are placed will 

remain when the fields are filled in. 

2. Type in number of underbars desired 

(shift/-). 

3. Data point to place the enter data 

field. 

 

Key-in: Place Text 

 

 

Note: Enter data fields are found in standard files such as a Title sheet.  

They are used to set standard fonts and sizes so that plans will appear 

uniform.  They are simply empty spaces reserved in a design file for 

standard information. 
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Enter Data Fill in Singular 

To enter data, fill in singular: 

 

1. Select Fill in Single Enter Data Field 

command. 

2. Identify the enter data field. 

3. Key in the text editor the contents for 

the enter data field Note: If you enter 

more characters than you have spaces, 

the entry will be truncated. 

4. Press <ENTER> to accept  

 

Key-in: Edit Single 

 

 

Enter Data Fill in Automatically  

To enter data, fill in automatically: 

 

1. Select Automatic Fill in Enter Data 

Fields command. 

2. Select desired view. 

3. Key in the text editor the contents of 

the data field Note: If you enter more 

characters than you have spaces, the 

entry will be truncated. 

4. Press <ENTER> to accept and will 

move automatically to the next enter 

data field. Note: Data fields will be 

located in order of creation. 

5. Repeat steps 3 & 4 or data point to 

skip to the next enter data field 

automatically. 

 

Key-in: Edit Auto 
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Copy Enter Data Fields 

To copy enter data field:  

1. Select Copy Enter Data Field command. 

2. Identify the enter data field with test to be 

copied. 

3. Identify the destination enter data field for 

the text. 

4. Reset to stop copying or choose a new 

destination. 

 

Key-in: Copy ED 

 

Copy & Increment Enter Data Field 

To copy and increment enter data field: 

1. Select Copy and Increment Enter 

Data Field command. 

2. Set the tag increment (between 1 and 

32767). 

3. Identify the enter field to copy and 

increment. 

4. Identify the destination of the enter 

data field. 

 

Key-in: Increment ED 

 

Enter Data Justify 

To enter data, justify: 

1. Key-in: Justify Left/Right/Center. 

2. Identify the enter data field.  (This is to change justification on existing or copied 

enter data fields). 
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VIEW ATTRIBUTE MENU 

 

Multi-line Text Nodes Display On/Off 

 

1. Toggle Text Nodes On/Off (Default - Off). 

2. Select View. 

3. Select Apply or All 

 

Key-in: Set Nodes On/Off 

 

Text On/off 

 

1. Toggle On/Off (Default - Off). 

2. Select View. 

3. Select Apply or All 

 

Key-in: Set Text On/Off 

 

Fast Font On/off 

 

1. Toggle On/Off (Default - Off). 

2. Select View. 

3. Select Apply or All 

 

Key-in: Set Font On/Off 

 

If the data field is not visible open the View Attributes Menu. 

Use the pull-down menu Settings > View Attributes or key in CTRL B 
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DROP ELEMENT SUB-PALETTE 

Drop Text 

To drop text: 

1. Select Drop Text command. 

2. Identify and accept the text element 

 

Key-in: Drop Text 
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DIMENSIONING SUB-PALETTE 

 

Association lock must be on to allow Dimensions to change with modifications 

 

Dimension Element: Place a dimension on an element. 

Dimension Linear: Place a linear dimension between two points. 

Dimension Angular: Place an angular dimension. 

Dimension Ordinates: Label distances along an axis. 

Change Dimension: Change a dimension to active dimension settings. 

Match Dimension Attributes: Change the active dimension attributes to match those of an 

existing dimension element. 

Re-associate Dimensions: Re-associate dimensions Tags Sub-palette 
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CHAPTER 8 

Reference Files 

Open Reference Menu 

You can open the Reference Menu on the pull-down menu under File > Reference or 

from the icon on the Primary Tool bar. 

 

Key-in: RF= (Reference File Name) 

 

 

Primary Tool Bar 

 

 

 

 

File Pull Down 
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To attach a reference file, click on Tool > Attach.  Navigate to correct directory and pick 

the file you want to attach. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose Coincident World for Orientation. Logical Name and Model will not be 

discussed in this course.  
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Once the file is attached the menu will look like this. This picture has all the “logicals” 

and prefixes attached for this project.   

DMS: MDT’s document 

management system “DMS” and 

Doc-u-plot require a prefix that 

satisfies file paths in this case 

MTRD: which is Road Design’s 

path. 
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LAB 1 
DESIGN FILE CREATION EXERCISE 

 

This exercise will result in the creation of the following files: 

 

• c:\dgn\lab1.dgn 

• c:\dgn\lab2.dgn 

 

Objective: 
Demonstrate comprehension of creating MicroStation design files using MicroStation 

manager, seed files, and working unit settings which match given criteria. 

 

Criteria: 
Create a design file named LAB1.DGN and LAB2.DGN when first activating 

MicroStation with the following criteria: 

 

1. Place in c:\dgn directory. 

2. Save Settings 

 

Instructions: (utilize seed file: MDT-Seed2D-Imperial.dgn) 
1. Exit completely out of MicroStation. 

2. Initialize MicroStation using “Preconstruction Startup” menu 

3. The first screen will be the MicroStation Manager, choose the New file option 

highlighted below. 

4. The Create New Design File Dialog box opens. The first step is to select a seed 

file. 
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5. Navigate to the desired directory where you want the file placed. 

6. Enter the file name you have chosen. 

7. Click Open and the file will open automatically. 
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LAB 2 

VIEW CONTROL EXERCISE 

 

Objective: Demonstrate comprehension of using MicroStation view controls by arranging 

five open windows to match given criteria. 

This exercise is completed using c:\dgn\intro.dgn 

In this file you will find a map of a road with several intersections.  On the map there are 

small green circles with a number inside each circle.  Your task is to arrange the widows 

so the corresponding number in the circle is in window with the same number.  (Window 

1 displays the circle with number 1). 

 

 

1. Open INTRO.DGN and arrange the five windows in the displayed pattern.  

 
 

 
 

 

 



154 

2. Using a variety of window manipulations, place the following views in the 

corresponding window. 

 

 

 
Note: Saving settings retains the desired views.  
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LAB 3 

BASIC ELEMENT PLACEMENT AND MANIPULATION 

 

Objective: Demonstrate comprehension using basic element placement and manipulation 

commands.  Upon successful completion of this exercise, the student will have completed 

the elementary drawings provided. 
 

 

1. Open file Lab2.dgn 

 

2. Draw figure 1-Lab 3. Use the PLACE LINE command and the PRIMARY 

TOOLS menu for different line style and weight.  Make the sides 100 feet tall and 

wide and the angle 110 (160) degrees to the other end.  Make it 300 feet long. 

 

 
 
 
 
 
  

Figure 1-Lab 3 
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3. Draw figure 2-lab 3. Use PLACE LINE, PLACE CIRCLE, COPY ELEMENT 

commands.  Use the PRIMARY TOOLS menu for different line style and weight.  

Make the length of these lines 200 feet long and 100 feet high.  Make the circles 

100 feet in diameter. 

 
 
 
 
 
 

Figure 2-Lab 3 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-Lab 3 
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4. Draw figure 3-lab 3. Use PLACE BLOCK, PLACE LINE, and COPY ELEMENT 

commands. Use the PRIMARY TOOLS menu for different line style and weight.  

Make these whatever sizes you prefer. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-Lab 3 
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LAB 4 

SAVED VIEW EXERCISE 

 

Objective: Demonstrate comprehension of using MicroStation saved view 

controls by saving six different views which match given criteria. 

 
This exercise is completed using c:\dgn\intro.dgn. 

In this file you will find a welcome message and a map of a road with several 

intersections.  On the map there are small green circles with a number inside each circle.  

Your task is to save individual views of each of these locations, save a view of entire 

alignment, and save a view of the introduction message.  

 

1. Arrange a window, of which you wish to create a saved view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Open the Saved View dialog box.  Save the view using the proper procedure. 
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3. After you key in the Name, Description etc.… select the view you wish the saved 

view to display on. Continue with the saved view procedure, until you have the 

five required saved views.  

 

 

 

 

4. After saving the five appropriate views, attach the views to different windows by 

selecting the desired view on the saved view menu then pick the on screen view 

you wish to assign the view to.  
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Check for view accuracy then use “save settings” to retain this layout next time 

you use this file. File > Save Settings 
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LAB 5 

Precision input Labs: Use the appropriate MicroStation commands to draw to follow 

diagrams: 

 

Use Place Line Command 

 

1. XY=10000,10000 or          4. DI=.6,225 or 

DATA POINT                           DL=-.4243, -.4243 

 

2. DI=1.5,0   or                      5. DI=1.5,180 or 

    DL=1.5,0                               DL=-1.5,0 

 

3. DI=.6,-45 or                       6. XY=10000,10000 or 

    DL=.4243, -.4243                  DI=.85,90 or 

                                                   DL=0,.85 or 

                                                   DATA POINT 

 

Use Place Smart Line Command 

 

1.  XY=10000,10000              4. DI= or 

                                                    DL= 

 

2. DI= or                                5. DI= or 

    DL=                                        DL= 

 

3. DI= or                                6. DI= or 

    DL=                                       DL= 

 

Use Place Block Command 

 

              DI= 

Or          DL= 

 

 

Use Place Circle by Center Command 

 

              DI= 

Or    DL= 
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LAB 6 

More Complex Element Placement and Manipulation 

 

Objective: Demonstrate comprehension of using MicroStation commands by completing 

a more difficult, continuous drawing (in this case, a residential area with surrounding 

woods and lake), using the commands discussed in the respective lectures. 

 

The drawing is started in this lab; in each subsequent lab exercise, the student will build 

upon and add to this core drawing until finally completing the project.  Thus, the student 

is able to implement what he has learned in a manner in which practical applications can 

be seen immediately. 
 

Note: Remember to SAVE SETTINGS and COMPRESS after each design lab. 

 

The objective of lab 5 is to familiarize the student with the more complex element 

placement and manipulation commands.  Refer Lab 5 illustrations. 

 

Before beginning delete all existing elements out of design file LAB1.DGN. 

  

1. Use place line command to make the Line 1030 Feet Long at an angle of 0 

degrees.  (See Figure 1-Lab 6) 

 

A. Zoom out until You See the 

Entire Line. 

 

B. Set Your Snap Mode to 

Midpoint or choose Midpoint 

on Snap Button Bar. 

 

C. Turn on Snap Lock. 

 

2. Set Angle = 90 Degrees (AA=key-in). 

 

A. Use the Rotate Copy 

Command to Rotate the 1030 

Foot-long Line Drawn at 90 

Degrees about its Center, 

Tentative Snap to the Center of 

the Original Line for the 

Second Data Point.  (See Figure 

1-Lab 6) 

 

B. Set Your Angle Back to 0 

Degree. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-lab 6 
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4. Use COPY PARALLEL command to create the 2 intersecting lines to create the 

streets. 

  (See Figure 2-Lab 6) 

 

A. Turn distance toggle on. 

 

B. Keyin distance = 15  

 

C. Place a copy on each side of 

line 

 

 

5. PARTIAL DELETE the copied lines 

as shown in Figure 3-lab 6, then 

EXTEND LINES TO 

INTERSECTION. 

 

6. Place curbs using CONSTRUCT 

CIRCULAR FILLET command with 

the truncate set to both and radius = 35 

(See Figure 4-lab 6).                
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-lab 6 

 

 
 

Figure 3-lab 6 

 

 
 

Figure 4-lab 6 
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7. Use CHANGE ELEMENT command to change centerline to style=4, weight = 1, 

color=4 

 

8. Use EXTEND LINE command with a negative value to decrease length of vertical line 

only, by 250 feet (See Figure 5-lab 6). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 

 

 

Figure 5-lab 6 
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LAB 7 

HOUSE CREATION 

 

Objective: In Lab 7 the student will create elements for addition to the core drawing started in 

Lab 6.  The particular commands covered in this lesson and preceding lessons will be used. 

In another area of your design file, draw the house and telephone pole as shown in Figure 1-lab 

7. 
 

1. First draw the house outline and roof. 

 

A. PLACE LINE using toggles in the dialog box.  Make the first line 50 ft long at 0 

degrees. 

 

B. ZOOM until you see the entire line 

 

C. Use the COPY PARALLEL command to copy the line 20 ft and 25 ft above the 

original line. 

 

D. Select the PLACE LINE command and use tentative to draw the 2 vertical walls. 

 

E. Use EXTEND LINE command to extend both ends of the line you copied at 20 ft 

by 3 ft. 

 

F. Select PLACE LINE command to connect each end of the extended line to 

connect with the upper line to complete the roof 

 

 

2. Next, draw the door. 

 

A. Select CONSTRUCT LINE BISECTOR command and identify the bottom line 

with a data point.  Keyin DI = 8,90.  This will draw the middle of the door exactly 

8 feet tall.  MDT Custom menu 

 

B. COPY PARALLEL this bisector line 3 feet away on each side. 

 

C. Use PLACE LINE command to draw the top line of the door.  (Make sure to use 

tentative to snap to the ends of the line.) 

 

D. Select ARC BY CENTER to place the arc on the top of the door.  Snap to the 3 

vertical lines of the door from right to left because the arc is drawn 

counterclockwise. 
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E. For the doorknobs, select CIRCLE BY RADIUS and keyin a radius of 2 inches 

(:2).  Tentative to the bottom of the original bisector. Note: do not enter a data 

point yet.  Keyin DL=.3,4.  This will draw the right doorknob, then key in 

DI=.6,180 to draw the other doorknob, or MIRROR a copy about the vertical 

axis of the bisector line. 

 

3. Now draw the windows. 

 

A. To draw the left window, first select the PLACE LINE command with a length 

of 9 and angle of 90.  Then TENTATIVE to the lower-left corner of the house.  

(Again, do not enter a data point here.)  Key in DL=11,4.  This should draw a 

vertical line that represents the center of the window. 

 

 

B. Use COPY PARALLEL, key-in 2 feet, and place a line on each side of vertical 

line drawn for each side of the window. 

 

C. Select PLACE LINE command and using TENTATIVE, draw the top and 

bottom of the window. 

 

 

D. Use the COPY PARALLEL command and key in 3 feet to copy the top or 

bottom of the window to complete the window panes.  Your left window should 

look similar to the one in Figure 3. 

 

E. The right window will be a mirror image of the left window.  Place a fence 

around the entire left window and then select MIRROR COPY, VERTICAL, 

using the original bisector of the door for the vertical line.  (Make sure you turn 

on FENCE toggle) 

 

 

4. Next, construct the chimney 3 feet from the left edge of the roof. 

 

A. Select the SMART LINE command and then snap to the upper-left corner of the 

roof (do not place data point yet). 

 

B. Key in 3 ft in x direction (this will place your first data point), then 3 ft in the y 

direction, then 3 ft in the -x direction, then 3 ft in the -y direction or keyin: 

 

DL=3,0 

 

DI=3,90 

 

DI=3,0 

 

DI=3,270 

 

and press the reset button.  This will complete construction of the house. 
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5. Last, construct the 75-foot telephone pole with the PLACE LINE command. 

 

A. Select PLACE LINE, then TENTATIVE to the lower-right corner of the house.  

(Do not enter a data point here.) 

 

B. Key in DI=25,0 (this will place your first data point).  Draw a 75-foot vertical 

line. 

 

C. TENTATIVE to the top of the pole while still in the PLACE LINE command.  

(Do not enter a data point.)  Key in DL=-3,0.  Draw a 6-foot line centered about 

the vertical line. 

 

D. Copy this top line down 10 feet with the COPY PARALLEL command. 

 

E. Extend the lower line 3 feet on each end with the EXTEND LINE command. 

 

 

NOTE: Other methods can be used for this drawing, however this step by step procedure covers 

all the commands presented in the lecture.  The telephone Pole in Figure 1-lab 7 is not to 

scale. 
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Figure 1-Lab 7 
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LAB 8 

USING FENCES 

In Lab 8 the student will continue with the core drawing started in Lab 6.  The particular 

commands covered in this lesson and preceding lessons will be used. 

The objective of Lab 8 is to manipulate elements using fences.  It also reinforces the material of 

the previous lecture concerning levels and grid manipulation.  Refer to figure 1-lab 8 for the 

exercise illustrations.  

 ELEMENT MANIPULATION 

 

1. Change your grid using grid setting box from settings menu.  Set your master grid to 10 

and reference grid to 12. (You will need to save setting so that you will not lose the grid 

setting after exiting the file) 

 

2. Create the blocks as shown in Figure 1, Illustration 1.  There are two ways to do this.  

One way is as follows: 

 

a. Place a fence around the street you previously created and change Fence Mode to 

Inside. 

b. Select MIRROR with Copy on, Mode Horizontal, Fence toggled on; snap to the 

end of the one of the vertical center lines and mirror the contents. 

c. Place a fence to include the newly mirrored elements. 

d. Continue to mirror the streets until your image looks like the one in Figure 1-Lab 

8, Illustration 1. 

 

3. Draw a lake in the middle block of the streets using the PLACE POINT CURVE 

command. 

 

4. Be sure to turn your fast curve display off so you can see the curve string.  This will now 

look like Figure 1-Lab 8, Illustration 1. 

 

5. You are now preparing to move the center lines to another level.  Make a graphic group 

out of the center line, using the GRAPHIC GROUP ADD command. 

 

6. Change your active level to three (LV=3). 

 

7. Select CHANGE ELEMENT command and select an element from the graphic group. 

(Make sure your graphic group lock is toggled on.) 

 

8. Change your active level back to level 1 (LV=1). 

 

9. Turn off level 3 so you are no longer looking at the center lines in view 1.  Your drawing 

will now look like Figure 1-Lab 8, Illustration 2. 

 

NOTE: Remember to SAVE SETTINGS and COMPRESS after each design session. 
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Figure 1-Lab 8 
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LAB 9 

CELL CREATION AND PLACEMENT 

 

Objective: In Lab 9 the student will continue building upon the core drawing of the previous lab 

sessions.  The particular commands covered in this lesson and preceding lessons will be used. 

The purpose of Lab 9 is to review the cell commands.  The student will use the elements drawn 

in previous lab exercises from which to create cells.  New cells will also be drawn in Lab 9.  

Refer to Figure 1-Lab 9 for the exercise illustrations. 
 

 REVIEWING THE CELL COMMANDS 

 

1. Create a cell from the house drawn in the Lab 6 exercise (HINT: Place cell origin on 

lower left corner) 

 

2. Use CELL MATRIX command or CM= number of rows, number of columns, distance 

between rows and distance between columns to place the houses on the streets as shown 

in Figure 1-lab 9 (2 rows, 10 columns).  You need to determine the distance needed 

between each row and column.  Place the cell matrix origin 25 feet from the edge of the 

street.   

 

HINT: Use active point for cell matrix origin. 

 

3. Draw a cul-de-sac at the end of one street with a 75-foot radius and 35-foot curb.  The 

steps are as follows: 

 

a. Extend the center line of the street 75 feet. 

b. Choose the PLACE ARC command and key in a radius of 75 feet.  On the left 

side of the drawing TENTATIVE to the end of the lower curb and accept to 

define the first point, TENTATIVE to the end of the center line and accept to 

define the center point and TENTATIVE to the end of the upper curb and accept 

to define the second point 

c. Shorten the line you extended by 75 feet. 

d. Use the CONSTRUCT CIRCULAR FILLET command and set truncate to both 

to place the curbs between the outer lines and arc.  Give a radius of 35 feet. 

 

4. Make a cell out of the cul-de-sac.  Put the origin at the end of the center line you 

shortened. 

 

5. Place these cells at the ends of the streets you created.  Make two cells larger than the 

original in different sizes. 

 

6. Use the DROP ELEMENT command on the cells and re-fillet them so that the arcs meet 

the streets (35-foot radius). 

 

 

 

NOTE: Remember to SAVE SETTINGS and COMPRESS after each design session. 



LAB 
L 174 

 

 

 

 

 

 

 

FIGURE  1-LAB 9 
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LAB 10 

CELL MANIPULATION 

 

In Lab 10 the student will continue building upon the core drawing of the previous lab sessions.  

The particular commands covered in this and preceding Labs will be used. 

 

Lab 10 is a continuation of work with cells (Lab 9).  It is also designed to give the student 

practice in using patterning, active points, and line terminators.  Refer to Lab 10 Figures 1, 2, and 

3 for the exercise illustrations. 
 

1. Create a cell of the telephone pole called POLE that you created in Lab 7. 

 

2. Create a cell representing a railroad track called RR. (This and the following cells are 

shown in Figure 1-Lab 10) 

 

3. Using the PLACE ACTIVE CELL command, place the cell TREE from the 

w:\rdstd\survey.cel into your drawing at a scale of 1.0.  Use the DROP ELEMENT 

command to drop the cell from a complex element. Use these elements to create a cell 

called TREE and place in the LABV8.CEL cell library. 

 

4. Create a water cell called WATER using the PLACE POINT CURVE command. 

 

5. Create a border cell called BORD. 

 

6. Create a terminator cell called ARROW with the origin at the point. 

 

7. Create a shingle cell called SNGL that is 1 foot long and 6 inches wide (Figure 1-Lab 

10.). 

 

8. Draw a curve string in the upper right corner block of your drawing as shown in Figure 2-

Lab 10. 

 

HINT: Leave a gap in the curve string between beginning and end. 

 

9. Draw a SMART LINE at the top of your drawing that will later be patterned as a 

railroad track (Figure 2-Lab 10). 

 

10. Draw a SMART LINE at the lower left of your drawing as shown in Figure 2-Lab 8 that 

will be used as a True North indicator. 

 

11. Turn off level 3 and draw the lines in the street that will point to the lake from the top left 

cul-de-sac. 

 

12. Draw a border around the drawing (4140 feet wide, 3030 feet high). 

 

13. Place a title block in the bottom right corner of the larger border (850-feet wide and 400-

feet high). 
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14. Use the command CONSTRUCT ACTIVE POINTS BETWEEN DATA POINTS to 

place nine telephone poles beside the houses on both streets. 

 

HINT: Use ACTIVE POINT tool with cell name = Pole (Lecture 5, page 62) 

 

 

 

15. Place 29 trees along the curve string in the upper right corner block using the command 

CONSTRUCT ACTIVE POINTS ALONG ELEMENT. 

 

HINT: Use ACTIVE POINT tool with cell name = Tree (Lecture 5 page 5-9) 

 

16. Delete the curve string behind the trees. 

 

 

NOTE: Remember to SAVE SETTINGS and COMPRESS after each design session.

FIGURE 1-Lab 10 
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FIGURE 2 - LAB  
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LAB 11 

PATTERN MANIPULATION 

 

 

1. Use the TRUNCATED CYCLE LINEAR PATTERN command to pattern the line 

string representing the railroad track. (See Figure 1-Lab 11) 

 

2. Make the water cell your active cell (AC=cell name).  Place several cells inside the lake. 

 

3. Place an arrow at the end of the True North indicator (Cell name = ARROW). 

 

4. Place line terminators on the lines used to indicate the way to the lake. 

 

5. Pattern the large border with the border pattern (linear). 

 

6. Pattern the title block border with the border pattern. 

 

7. Set your active scale to 15 and place a house cell outside your border.  Drop status on this 

house cell. 

 

8. Create a complex shape of the roof of the house.  Use the AREA PATTERN command 

to pattern the roof. (HINT: Be sure pattern scale is set to 15) Your drawing should now 

resemble figure 1-Lab 11. 
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Figure 1-Lab 11 
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LAB 12 

TEXT PLACEMENT 

Objective: In Lab 12 the student will continue building upon the core drawing of the previous lab 

sessions.  The particular commands covered in the preceding labs will be used. 

 

Lab 12 covers the majority of the text commands discussed in the lecture on text placement.  The 

purpose of the exercise is to give hands-on practice in the basic material presented during the 

classroom session.  Refer to Figure 1 – Lab 12 for the exercise illustration. 

 

 THE TEXT COMMANDS 
 

NOTE: Place all text on level 9. 

 

1. Draw a creek, using the PLACE POINT CURVE command below the railroad.  COPY 

PARALLEL this line 50 feet.  (See Figure 1-Lab 10) 

 

2. Place text naming the creek along a point curve (The name should appear between the 

two point curves) 

 

3. Key in FT=42.  Place text above the lake. 

 

4. Key in FT=23.  Place the name BANKHEAD WOODS at the right of the woods. 

 

5. Place your name, the date, and company name (FT=71) in the title block of your drawing. 

 

6. Place THIS WAY TO LAKE (FT=42) as shown in Figure 1-Lab 12. 

 

7. Place TRUE NORTH INDICATOR (FT=42). 

 

8. Place text above the line to place street names on the streets, using your choice of font. 

 

9. Put numbers on your houses using the following steps: 

 

a. Place a house cell in your design file (AS=1). 

b. Drop element on the cell. 

c. Add enter data fields below the house.  (It will look like figure 2-Lab 12). 

d. Delete the old house cell from your cell library. 

e. Name a new house cell the same as the house you just deleted. 

f. Use the REPLACE CELL command and replace the old houses with the new 

ones.  Now place numbers in the enter data fields using ENTER DATA 

SINGULAR and COPY AND INCREMENT the enter data fields. (See Figure 

3-Lab 12) 

 

NOTE: Remember to SAVE SETTINGS and COMPRESS after each design session 
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Figure 1-Lab 12 
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FIGURE 2-LAB 12 
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MDT Basic MicroStation 3D drawing and model manipulation exercise. (You probably 

recall this building from the MDT Introduction to MicroStation manual it was placed and 

drawn in 2D on the road side of your plan). REV: 4 

1) As reviewed earlier in this manual (MDT Introduction to MicroStation manual) 

create a new file utilizing MDT “MDT-Seed3D-Imperial.dgn” seed file.  

 
1) Open your first 4 views using view control at the bottom of your screen. 

 

Then select the pull-down Menu Window > Tile to fit all 4 views to your screen. 
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2) In the Front view draw a rectangle 50 X 20 using the MicroStation Place 

Block command to construct the front wall of the house. 

 

This is the objective: 

 
 

3) Again, use the Place Block command to construct your first window by 

using tentative (not data point) to the lower left corner of the wall, then key 

in DX=9,4 to locate and begin the lower left corner of the window. Draw a 

9 X 4 block. You will draw a door later. 

 

Use the Mirror command to mirror your window about the mid-point of the 

wall 

 

As showed: 
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4) Select the create region tool: 

 
 

Set it to Flood and Locate Interior shapes: 

 

 
 

Select the inside of the wall to create a region of your wall: 
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5) Open the Feature Modeling task bar (When in a 3D model the “Feature 

Modeling” task is available). 
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6) Select the Extrude Feature tool: 

 
 

7) Key-in a distance of 0.8 

 

 
 

Select your wall and move the cursor to the internal direction to create a 0.8 distance. 
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8) Go to the Right view and use the place block command to draw a 

rectangle 28.4 x 20. Use snaps to ensure connection to the lower inside 

portion of the wall you have just drawn. 

 
In the Isometric view use the Extrude Feature and select your wall and move the cursor 

to the internal direction to create a 0.8 distance.  
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9) Copy the new side wall over to the opposite side using the proper snaps 

as shown low below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Do the same for the Front wall to achieve the following results: 
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10) Use the Place block command to draw an 6 X 8 door at the mid-point of 

in the Front view. 

 
 

11) Use the Place Arc command to construct an archway on top of the door: 

Set the Method to Start, Center. 
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12) Trim out the top line of the door (leave the bottom as is): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13) Use the Cut feature tool with settings as shown below to open the door 

way: 

 

 

 

1) First select the Front wall then 2) select the top doorway Arc: Data 

point to accept. (2 PICK PROCESS) 
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14) Go to the Right view and construct the side of the roof as follows: 

 

15) Use the Extrude feature command with a distance of 0.8 to match what is 

shown below: 
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16) Copy the side roof over to the opposite side using the proper snaps as 

shown below: 

 

17) Construct a line as shown below across the top of the structure (Red is 

used only to highlight the action): 
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18) Extend the line by a value of 3 on each side: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

19) Copy this line over to the two locations as shown below (Use your snaps). 
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20) Use the Place Shape tool and connect 4 closed points to create the top 

half of your roof as shown below. Repeat this for the opposite side of the 

roof: 

 
 

21) In the Top View Draw a symmetrical 4 X 4 chimney. Move the chimney 

slightly outside the external wall, do not eye the move but move it with a 

direct value input (or snaps) to keep properly aligned with the 3D model. 
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22) Use the Extrude Feature with a distance of 28 and a thickness of 1 in an 

upward direction to complete the chimney. 

 
 

 

23) Hold down your cursor here to sample various shading modes: 
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Congratulations you’ve created a 3D model! 

 

24) Let’s move our models view perspective in the isometric view: Select View 

Rotation: Rotate view then data point, then move your cursor around to 

watch your perspective spin freely about the model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can also experiment with the View Perspective: Change View Perspective tool to 

experience perspective changes. 

 


